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ABSTRACT 
 
 

 
CHARACTERIZATION AND CONTROL OF INTUMESCENCE DEVELOPMENT FOR 

CAPSICUM ANNUUM PRODUCTION IN CONTROLLED ENVIRONMENTS 
 

 
 

 Capsicum annuum (pepper) is an emerging crop for controlled environment production 

that is susceptible to intumescence. Intumescence is a physiological disorder characterized by 

unrestricted cellular elongation causing protruding lesions, ultimately leading to epidermal 

rupture. While the causative factor for this disorder remains unknown, water stress is commonly 

implicated, and end-of-day (EOD) lighting strategies have been identified as a potential strategy 

for mitigating intumescence development. However, the timing of pepper leaf area expansion 

and intumescence development as well as appropriate lighting strategies for their control have 

yet to be determined. The objectives of this work were to 1) determine the timing of leaf area 

expansion to better inform EOD or pre-dawn (PD) lighting applications for intumescence 

suppression; 2) quantify the impact of low-intensity lighting applications on pepper leaf 

morphology; and 3) determine the role of water stress in the occurrence of intumescence 

development for pepper. Pepper ‘Pot-a-Peño’, ‘Spicy Jane’, and ‘California Wonder’ were 

grown in 15-cm pots in a common greenhouse environment. For Objective 1, three weeks after 

transplant, one uniform leaf on each plant was tagged and plants were evaluated twice a day 

(0700 and 1900) for one week. For Objective 2, plants were subjected to 30-minute lighting 

treatments at an intensity of 25 μmol·m−2·s−1 for two weeks provided at either EOD with blue 

(EODB; 447 nm), red (EODR; 659 nm), or far-red light (EODFR; 734 nm), or PD with blue light 

(PDB; 447 nm). For Objective 3, plants were either maintained at 70% container capacity 
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(control) or allowed a single dry down event reaching 40% container capacity prior to watering 

event. Intumescence development was visually monitored twice a day (0900) and (1700) during 

the water stress event. For Objective 1, leaf area expansion was greater at nighttime (NT) (1900-

0700) compared to the daytime (DT) (0700-1900) with NT accounting for 66%, 57%, and 59% 

of total leaf area expansion for ‘California Wonder’, ‘Pot-a-Peño’, and ‘Spicy Jane’, 

respectively. For Objective 2, responses to lighting treatments were cultivar specific. For 

example, after two weeks, imaged leaf area was lowest under EODB for ‘Pot-a-Peño’ and 

greatest under EODFR for ‘Spicy Jane’. For Objective 3, intumescence development was 

observed on all cultivars subjected to water stress post returning to container capacity, with no 

incidence of the disorder for control plants. These results will help in the prediction of 

intumescence development for pepper produced in controlled environments and inform decisions 

regarding the timing of possible suppression methods to control this disorder.   
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CHAPTER 1. INTRODUCTION AND LITERATURE REVIEW 
 
 

 

1.1 Controlled Environment Agriculture and Intumescence 

Controlled environment agriculture (CEA) has been expanding globally at an accelerated 

rate; the number of CEA operations almost tripled from 1998 to 2019 in the United States (US), 

and continued growth of this sector is expected (Dohlman et al. 2024). Production in a controlled 

environment (e.g., greenhouse, vertical farm) allows for the control and fine-tuning of 

environmental conditions during crop production compared to the field. The production of 

specialty crops in controlled environments, in particular, increased 56% between 2009 to 2019 

(Dohlman et al. 2024). This rapid expansion is due in part to the invention of light-emitting 

diodes (LEDs) in the early 1960’s, which have since been implemented in controlled 

environment systems allowing multiple benefits compared to traditional lighting sources [e.g., 

high-intensity discharge (HID) lamps] including greater spectral control and reduced energy use 

(Nemali 2022). Ultimately, these advancements allow improved control over the quantity and 

quality of light provided throughout production as well as the benefit of cost savings due to an 

improved lamp efficacy. These technological advances enable year-round food production in 

CEA systems, versus conventional farming systems that are subject to typical production season 

cycles and the unpredictability of weather conditions. While conventional farming methods are 

critical for sustained production of staple crops [e.g., corn (Zea mays), soybean (Glycine max), 

rice (Oryza sativa)] in the US, the reduction of farmable land, increased occurrence of extreme 

weather events, and increased labor costs have led to the consideration of alternative systems, 

such as CEA, to manage food securities (World Food and Agriculture 2023). The incorporation 

of specialty food crops can benefit farmers by diversifying their revenue, providing flexibility in 
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choosing climate-appropriate species, and maintaining yields with fewer resources (Kim 2016). 

CEA remains a small sector compared to conventional farming but allows for more control and 

protection against adverse weather conditions for high value specialty crops. CEA production of 

high value specialty crops includes species such as tomato (Solanum lycopersicum), cucumber 

(Cucumis sativus), lettuce (Lactuca sativa), strawberry (Fragaria × ananassa), basil (Ocimum 

basilicum), and pepper (Capsicum annuum) (Dohlman et al. 2024). Staple food crops, such as 

rice and wheat (Triticum aestivum), are not economically feasible for indoor production in part 

due to high input costs and a relatively low market price (e.g., US$0.40 kg−1 for rice and wheat; 

Pattison et al. 2018). While production in controlled environments has a high inherent cost, 

specialty crops have proven to be sustainable and profitable. For example, the US fresh market 

price in 2018 was reported $35 kg−1 for leafy microgreens, $12 kg−1 for lettuce, and $8 kg−1 for 

tomatoes (Pattison et al. 2018). Peppers are an emerging high value crop in CEA which is 

gaining popularity due to its nutritional, culinary, and cultural value (USAID 2014).   

As mentioned previously, there are many challenges with the shift from field production 

to CEA including the high initial capital investment for the construction of these facilities (Wei 

et al. 2020) as well as operating costs pertaining to sustained production and a lack of skilled 

labor. Due to the closed nature of CEA, some diseases and disorders become magnified in 

controlled environments when compared to conventional farming (Singh et al. 2020). Previous 

literature has mentioned common CEA disorders including blossom end rot, fruit cracking, 

curved fruits, fruit zippering, and leaf roll (Savvas et al. 2008), oedema (Bewley 1934), and 

intumescence (Sorauer 1922).  

Intumescence is a physiological disorder affecting many specialty crop species that has 

primarily been documented to occur in controlled environments (Sorauer 1922). Intumescence 
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development is characterized by the swelling of palisade parenchyma and spongy parenchyma 

cells, which eventually rupture the epidermal layer (Lang and Tibbitts 1983). Intumescence has 

been reported to develop on stems, both the abaxial and adaxial surfaces of leaves, and flower 

buds (Sorauer 1922). While this disorder has been documented for over 140 years, the 

mechanism of action is not well understood. Previous research has suggested a variety of 

causative factors for intumescence development including high humidity, low transpiration rate, 

light quality (spectrum), light intensity, calcium supply, and/or mechanical damage (Pinkard et 

al. 2006). This review will detail historical and current events regarding intumescence injury and 

how it continues to impact producers. 

1.2 History, Anatomy, and Nomenclature 

1.2.1 History and background 

The term intumescence was first documented by German botanist and plant pathologist 

Paul Sorauer in his book Manual of Plant Diseases in the late 1800s (Sorauer 1922). This was 

later translated to English in 1922. His description of intumescence structures was reported to be 

“knot-like” or “pustule-like" protrusions that tend to occur in groups. His detailed microscopic 

observations of the protrusions led to the understanding that this disorder involves the upper 

palisade parenchyma and spongy parenchyma cells (Sorauer 1922). He noticed the palisade 

parenchyma and spongy parenchyma cells continue to elongate and eventually push through and 

rupture the epidermal layer. Sorauer (1922) also noted that chloroplasts tend to disappear as the 

cells become elongated. This observation was supported by Atkinson (1893), using the term 

oedema (nomenclature described below), who noted that while the concentration of chlorophyll 

in the cell did not change, the grains were further separated in their distribution within the 

enlarged cell. Intumescence has been observed and described in a variety of ways on multiple 
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plant species. Since the turn of the 20th century, there have been reports of intumescence 

development in over 14 plant families and 80 species (Pinkard et al. 2006; Sita et al 2024). 

1.2.2 Anatomy and physiology  

Understanding the anatomical and physiological basis of intumescence is essential for 

developing effective mitigation strategies in sensitive crops like tomato and pepper. Older 

studies conducted by Atkinson (1893) and Sourar (1922) provide foundational basics for 

describing the structure of intumescence lesions primarily in tomatoes. La Rue (1933) later 

expanded research of this disorder focusing on poplars, but more clarification is still needed due 

to the various ways intumescence presents itself on different species.  

Anatomically, intumescence lesions originate primarily in the inner tissues of the leaf, 

particularly the palisade parenchyma and spongy mesophyll layers (Sorauer 1922). These cells 

become hypertrophied, losing their structural uniformity, and begin to exert pressure on the 

overlying epidermis causing characteristic protrusions, often leading to rupture or separation 

(Eisa and Dobrenz 1971; Suzuki et al. 2020). Early stages of development are typically marked 

by green or whitish bumps that become mounded until epidermal rupture, these bumps can occur 

along the leaf vein and or interveinally (Craver et al. 2014a; Rud 2009). In terms of location, 

lesion development on tomato ‘Maxifort’ and ornamental sweet potato (Ipomoea batatas) 

‘Blackie’ occurred primarily on the adaxial surface of the leaf but occurred on the adaxial and 

abaxial side of the leaf for bat-faced cuphea (Cuphea llavea) ‘Tiny Mice’ (Craver et al. 2014a).  

1.2.3 Nomenclature Differences 

Differing descriptions of protruding structures has led to a difference in nomenclature 

when describing this disorder. Some of the terms utilized in the literature include excrescences 

(Hahn et al. 1920), genetic or leaf tumors (La Rue 1933), edema (Morrow and Tibbitts, 1988), 
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and oedema (Atkinson 1893; Craver et al. 2014a). Each of these names have been used in 

attempts to classify this disorder on a variety of plant species (Pinkard et al., 2006) (Table 1.) 

The abundance of names has led to confusion regarding the appropriate terminology for 

this disorder. Lang and Tibbitts (1983) suggested the term intumescence as appropriate during 

their study with cultivated tomato (Lycopersicon esculentum Mill.) ‘Oxheart’. The use of the 

term intumescence was further supported by Williams et al. (2015) with a description of the 

disorder as being marked by the elongation of epidermal cells and rapid expansion of palisade 

parenchyma cells that rise above the laminar surface. This is in contrast to the term oedema, 

whereby hypertrophied mesophyll cells form watery blister-like lesions associated with excess 

water accumulation (Lang and Tibbitts 1983; Williams et al. 2015). Ji Hye Yun et al. (2024) 

used the term intumescence when researching this disorder in grafted pepper ‘Sunhan Gilsand’ 

and ‘Nokkwang’ as well as tomato ‘TY Haruakki’ and ‘TTM-130’ placed in growth chambers 

under LED lighting. Cruz et al. (2023) also used the term intumescence when evaluating 

compact peppers grown indoors. With “intumescence” typically associated with the disorder 

developing on species within the Solanaceae family, this term will be used, as appropriate, for 

the remainder of this review.  

1.3 Causative Factor 

Since the early 1890s, possible causative factors of intumescence injury have been a 

continuous topic of research across various plant families. Following the initial observations, 

there have been reports of intumescence injury in over 14 plant families and more than 80 

species (Table 1).  
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1.3.1 Genetics 

Genetic predisposition has been reported to play a role in plant susceptibility to 

intumescence. Suarez et al. (2023) observed that tomato ‘Maxifort’, ‘Camaro’, and ‘Patio’ 

showed differing intumescence development under the same greenhouse conditions. For 

example, tomato ‘Maxifort’ showed the highest incidence of intumescence over time compared 

to ‘Camaro’, whereas ‘Patio’ developed the least incidence showing differences in cultivar 

susceptibility to the disorder. Researchers using quantitative trait loci (QTL) mapping in tomato 

recombinant inbred line (RIL) populations found that specific QTLs associated with 

chromosome 1 influence how different cultivars respond to environmental stressors such as light 

and humidity (Prinzenberg et al. 2022). Prinzenberg (2022) also found the RIL population 

derived from less susceptible parent lines had less intumescence development themselves. 

Modern genomic tools, such as transcriptomics and CRISPR-based gene editing, may offer 

promising approaches to identifying and manipulating genes responsible for intumescence 

resistance. This cultivar-specific response shows interest in the potential for breeding programs 

aimed at developing intumescence-resistant varieties for CEA production. As more species are 

studied under controlled environment conditions, the documentation of susceptible and tolerant 

genotypes will become more robust, facilitating targeted cultivar development. 

1.3.2 Humidity and Excess water  

High humidity environments limit transpiration by reducing the amount of water vapor 

escaping the stomata, leading to water accumulation in plant tissues. This buildup of internal 

pressure can cause cells to stretch and burst, particularly in young, rapidly expanding leaves 

(Retana-Cordero et al. 2022). 
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Atkinson (1893) noticed a disorder involving epidermal cells of tomato that became 

enlarged and would easily separate and fall off when the plants were grown in a humid 

greenhouse, which he associated with oedema. Dale (1901) conducted field experiments with 

Hibiscus vitifolius to identify a cause for intumescence development by enclosing various parts 

of the plant within colored glass or by growing the entire plant in a pit covered with glazing. 

Their results further supported the involvement of high humidity condition with intumescence 

development (Dale 1901). Lang and Tibbits (1983) found callus-like masses on two species of 

tomato, cultivated tomato ‘Oxheart’, and wild type tomato (Lycopersicon hirsutum) ‘PI LA 

1625’, when exposed to 30% relative humidity, but lesions were less obvious than those exposed 

to higher relative humidities of 80% or 92%. 

Hydroponic systems can also contribute to intumescence development due to the 

abundance of water availability. Suarez et al. (2023) showed that tomato ‘Maxifort’ and ‘Patio’ 

grown in indoor hydroponic systems developed more lesions than those grown in soil, attributing 

the difference to reduced transpiration and increased root zone moisture. More research is needed 

to understand the full interaction between hydroponic production and intumescence 

development.  

1.3.3 Temperature 

High tempeatures (>30 °C) affect plant physiology by increasing metabolic rates and 

altering water movement through transpiration (Erickson and Markhart 2001). For CEA, 

elevated temperatures paired with high humidity reduces the vapor pressure deficit (VPD), this 

reduction impedes transpiration and results in excess water accumulation within leaf tissues 

(Jones 1993). This internal pressure builds up and contributes to cellular hypertrophy, leading to 

the characteristic of swelling and blistering seen in intumescences (Erickson and Markhart 
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2001). Early research into the mechanisms of intumescence found tomato plants exposed to 

elevated temperatures during the day showed higher incidence of intumescence injury (Lang and 

Tibbitts 1983). In a more recent study involving tomato ‘CF Rinka 409’, observations of 

structural damage caused by intumescence was more severe when plants were subjected to both a 

warmer temperature and high humidity (Suzuki et al. 2020). Retana-Cordero et al. (2022) also 

noted elevated temperatures in combination with specific light spectra and high humidity 

increased intumescence severity. Eisa and Dobrenz (1971) studied the effects of high 

temperature (30 °C) and high relative humidity (82-93%) in eggplant (Solanum melongena) and 

concluded these environmental conditions are an essential component in predisposing plants to 

intumescence development. 

1.3.4 Water deficit 

Under normal conditions, cell expansion and turgor pressure are tightly regulated by 

water uptake (Hsiao and Acevedo 1975). When plants experience water deficit, reduced turgor 

pressure can lead to abnormal cellular expansion or disruption of epidermal cell integrity (Munns 

et al. 2000; Pantin et al. 2011). In recent research on potted hot peppers ‘Pusajuala’ and ‘Ghotki’ 

and bell pepper ‘Green Wonder’ and ‘PPE-311’, drought conditions were initiated when the 

plant was maintained at 35% field capacity, whereas normal conditions were maintained at 65% 

field capacity, marking thresholds for pepper water needs (Mahmood et al. 2021). Drought stress 

also induces a complex hormonal response, including elevated levels of abscisic acid (ABA), 

which regulates stomatal closure to prevent water loss. However, this regulation can 

inadvertently lead to heat stress and buildup of reactive oxygen species (ROS), which further 

damage plant tissues (Mahmood et al. 2021). Such oxidative stress may contribute to 

intumescence lesions, due to oxidative imbalances influencing cell wall changes and cellular 



 

 9 

proliferation (Mahmood et al. 2021). Molla et al. (2023) observed significant variability in 

physiological responses to drought stress between Ethiopian red pepper ‘Local’ and 

‘Markofana’, suggesting cultivar-specific leaf anatomy may influence susceptibility to water 

stress. Additionally, Miyama and Yasui (2021) conducted experiments on tomato ‘Momotaro 

Peace’ and ‘Reiyo’ and found that intumescence incidence varied significantly depending on the 

cultivar under different watering regimes. Their study included a dry condition of 50% relative 

humidity and no irrigation, and a wet condition of 90% relative humidity with sub irrigation; 

they found cells are more likely to rupture when water potential increases after a shift from dry 

to wet conditions, demonstrating a significant role of water status for intumescence development 

(Miyama and Yasui 2021). Water deficit often occurs with other stress factors such as high 

irradiance or imbalanced light spectra. Recent studies have shown that plants grown under UV-

deficient or high blue light conditions are more prone to intumescence formation when also 

experiencing water stress (Eguchi et al. 2016b; Williams et al. 2016). Pantin et al. (2011) 

emphasized that the control of leaf expansion shifts from metabolic (driven by the availability of 

carbohydrates) to hydraulic (driven by water potential and transpiration rates) regulation under 

drought. These shifts may disrupt leaf growth patterns in susceptible cultivars and possibly 

promote the formation of intumescences. Hoffmann et al. (2015) demonstrated that pepper plants 

acclimated to high blue light showed less vulnerabilities to water deficit, suggesting target use of 

light quality can improve plant performance under stress conditions. 

1.3.5 Light 

Plants perceive light across a range of wavelengths including ultraviolet (UV), blue (400-

500 nm), green (500-600 nm), red (600-700 nm), and far-red (700-800 nm). Plant growth is 

driven by the light reactions of photosynthesis, ultimately resulting in the generation of 
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carbohydrates enabling the building blocks for cell walls and organs (Hart 1988; Lopez and 

Runkle 2017). The wavelengths that directly contribute to photosynthesis are termed 

photosynthetically active radiation (PAR; 400-700 nm) (Lopez and Runkle 2017). Light intensity 

is measured by determining the number of photons within a square meter per second (µmol·m–

2·s–1) (Lopez and Runkle 2017). Photosynthetic photon flux density (PPFD; µmol·m–2·s–1) 

provides a measurement of light intensity within the PAR wavelength range. The daily light 

integral (DLI; mol·m–2·d–1) can further be determined by integrating PPFD over a 24-h period 

(Lopez and Runkle 2017). While red and blue wavelengths of light have the highest efficiencies 

for driving photosynthesis, wavelengths both within and outside of the PAR spectrum have been 

found to impact plant physiology and metabolism (Lopez and Runkle 2017).  

In addition to driving photochemistry, light serves as a signal to the plant which drives 

changes in plant growth and development. There are three classes of photoreceptor proteins that 

are part of the pigment system plants use to gather information regarding the light environment 

around them (Kendrick et al. 1993). The three classes include: phytochromes, which primarily 

absorbs red and far-red light to signal a multitude of plant responses including flowering and 

“shade avoidance”; cryptochromes, which primarily absorb UV-A (320-400 nm) and blue light 

signaling de-etiolation, flowering, and circadian oscillation; and phytotropins, which absorb UV-

A, blue, and green light regulating phototropism, the movement of chloroplasts, and stomatal 

opening (Cope et al. 2014). As plant responses to light quality are often species-specific, 

manipulation of these spectra has also shown to be a tool in reducing intumescence development. 

1.3.5.1 Ultra-violet 

Emerging technologies in CEA lighting allow for dynamic control over the light 

spectrum, offering a potential tool for mitigating intumescence. However, balancing light quality 
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for both growth optimization and lesion prevention remains a challenge, especially within multi-

species cultivation systems. Historically, light quality is suggested to be one of the factors 

involved in the development of intumescence. Typical greenhouse construction involves glazing 

materials with UV-blocking properties to protect equipment, plant material, and greenhouse 

laborers from exposure (Both and Faust 2017). Since intumescence development is unique to 

production in controlled environments, one proposed causative factor for this disorder has been 

the absence of UV light, particularly UV-B (280-320 nm), as a result of greenhouse glazing 

materials. Lang and Tibbitts (1983) found intumescence was prevented in tomato ‘Oxheart’ and 

wild type tomato ‘PI LA 1625’ grown under fluorescent UV lamps when housed in Plexiglas 

boxes that allowed the transmission of UV-B; in contrast, the same tomato cultivars grown in 

Plexiglas boxes that blocked UV-B radiation developed severe intumescence injury. Further, 

Craver et al. (2014b) observed the development of intumescences on ornamental sweet potato 

‘Ace of Spades’ in a UV-deficient greenhouse environment, but the disorder was suppressed 

when supplemental UV-B was provided at an intensity of approximately 0.8 W·m–2 (Craver et al. 

2014b). Similarly, Eguchi et al. (2016a) noted the inclusion of a small amount of UV-B (0.23 

mmol·m–2·s–1; 0.33% of PPFD) emitted from sole-source cool white fluorescent lamps likely 

prevented the development of intumescence in tomato ‘Beaufort’ seedlings when compared to 

the same plants grown in the absence of UV-B and far-red light. The absence of the UV-B and 

far-red wavelengths also resulted in morphological abnormalities in tomato seedling ‘Beaufort’ 

such as excessive stem elongation, while the inclusion of these wavelengths was shown to 

facilitate the suppression of intumescence formation and maintain desired morphological traits 

(Eguchi et al. 2016a).  
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1.3.5.2 Red and Far-red light  

Red and far-red light are detected by phytochromes, primarily phytochrome B which is 

comprised of a protein that has two interconvertible forms: a red absorbing inactive form (Pr) and 

a far-red absorbing active form (Pfr) (Hernandez and Kubota 2017). These interconvertible forms 

change depending on the ratio of red to far-red light (R:FR). Pr absorbs red light and results in 

the conversion to Pfr, while the reverse occurs as Pfr absorbs far-red light (Jishi 2024). The 

proportion of phytochrome in the active Pfr form is an indicator for biological responses and is 

commonly referred to as phytochrome photostationary state (PSS; Pfr/PTotal) (Jishi 2024). A low 

PSS ratio (0.10/0.50) would typically be experienced under a canopy and is considered high in 

the far-red spectrum (Hernandez and Kubota 2017). A low PSS commonly results in the 

promotion of shade-avoidance responses, this response has generally been characterized by stem 

elongation, leaf expansion, and biomass accumulation as well as provide critical signaling in the 

regulation of flowering, dormancy, and seed germination (Hernandez and Kubota 2017). 

Whereas a high PSS ratio (0.75/0.89) would typically be experienced in full sun and be 

considered high in the red spectrum (Hernandez and Kubota 2017). A high PSS commonly 

results in the suppression of the previously described shade avoidance responses (Casal 2013).  

CEA has taken advantage of the physiological responses to red and far-red lighting to implement 

strategies to promote desired traits. One of those strategies is the use of end-of-day (EOD) 

lighting. EOD red and far-red applications can extend the photoperiod, promote stem elongation 

(which is desired during cut flower and rootstock production), regulate the timing of flowering, 

as well as mitigate physiological disorders such as intumescence (Eguchi et al. 2016a; Hernandez 

and Kubota 2017). For example, Morrow and Tibbits (1988) found an application of far-red light 

at 10 µmol·m–2·s–1 was effective in reducing intumescence development to 1% of a leaf disc 
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surface area in wild tomato ‘PI LA 1625’ when provided immediately following exposure to red 

light (80 µmol·m–2·s–1) compared to red light alone.  

1.3.5.3 Blue Light 

Blue wavelengths of light play a critical role in photomorphogenic responses such as 

stomatal regulation affecting CO2 diffusion and water relations, stem elongation, and 

phototropism (Massa et al. 2008). Blue light is detected by cryptochromes signaling de-

etiolation, restriction of cellular expansion (at high light intensities), flowering, and circadian 

oscillation (Cope et al. 2014). Blue light also stimulates cellular expansion patterns and cell 

division, specifically within the mesophyll tissues of leaves, leading to packed palisade 

mesophyll cells and enhanced development of spongy mesophyll cells ultimately resulting in 

thicker leaves (Dou and Niu 2020). Photomorphogenic responses to monochromatic blue light 

are species-specific. For example, when cabbage (Brassica campestris), lettuce, and radish 

(Raphanus sativus) were grown under sole-source blue light, plants were all shorter and more 

compact compared to plants grown under mixed spectra lighting including red wavelengths 

(Hernandez and Kubota 2017). This is in contrast to responses in cucumber and pepper, where 

increased stem elongation and leaf area was observed under monochromatic blue light 

(Hernandez and Kubota, 2017). Cope et al. (2014) found in pepper ‘California Wonder’, blue 

light decreased leaf area expansion regardless of increasing intensities (200 µmol·m–2·s–1 or 500 

µmol·m–2·s–1). In the same study, stem length increased alongside increasing blue light 

percentage (12-92% PPFD) in pepper ‘California Wonder’, which was the opposite response 

when compared to lettuce ‘Waldmann’s Green’ and radish ‘Cherry Belle’ where stem length 

decreased as the percentage of blue light increased (Cope et al. 2014). CEA production systems 

increasingly leverage blue light to manipulate crop morphology, particularly for leafy greens, 
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tomatoes, and peppers where compactness and quality are critical traits that directly affect future 

profits (Benke and Tomkins 2017; Gómez et al. 2019). The addition of blue light to EOD 

lighting has shown to decrease the incidence of intumescence injury in tomato plants. For 

example, Eguchi et al. (2016a) studied tomato ‘Beaufort’, a cultivar highly susceptible to 

intumescence, and found the use of a high intensity blue light (75% of PPFD) during the 

photoperiod under sole-source lighting followed by a small dose of EOD far-red light (5.2 

µmol·m–2·s–1) applied for 3.3 minutes contributed an additional 5% suppression of intumescence 

injury without negative influences on growth and morphology when compared to the use of low 

intensity blue light (10% of PPFD) .  

As discussed, plants responses to various combinations of light spectrum within CEA 

production are species-specific. Specifically, peppers exhibit responses to blue light that are in 

contrast to other species (Cope et al. 2014; Hernandez and Kubota 2017), highlighting the need 

for further research into their specific responses to blue light as well as blue lights impact to 

mitigate intumescence injury.  

1.4 Importance of Peppers 

Pepper cultivation, including both sweet (e.g., bell peppers) and hot varieties (e.g., 

jalapeños, habaneros), plays a vital role in US agriculture. In 2021, U.S. producers harvested 

over 31,000 acres of bell peppers and more than 10,000 acres of hot peppers, yielding a 

combined production value over $536 million (Lawrence 2022). The market itself for specialty 

and spicy peppers has grown significantly in recent decades. Per capita consumption of hot 

peppers in the US rose from just over three pounds in 1980 to more than seven pounds by 2020 

(Woods and Thornsbury 2021). 
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Despite its economic importance and consumer demand, domestic production has 

experienced a decline. Between 2000 and 2015, bell pepper acreage in the U.S. dropped from 

62,080 to 40,900 acres, largely due to increased competition from imports, regulatory changes, 

and labor shortages (Biswas et al. 2018). Between 2000 and 2015, US fresh pepper imports 

increased from 436 million pounds to 1.42 billion pounds, with Mexico accounting for nearly 

87% of these imports by 2015 (Biswas et al. 2018). In light of these changes, US pepper growers 

have faced higher production costs and reduced yields, making it increasingly difficult for 

domestic producers to compete with imported peppers (Leskovar 2014). With much of the US 

demand currently being met by imports, this growing popularity presents an opportunity for 

domestic producers to expand into high-value niche markets. 

While field production of peppers occurs during the warmer summer months, 

environmental stressors, such as drought and heat, have adversely affected US pepper 

production, especially in the southwest (Leskovar 2014). To overcome the challenges associated 

with open-field cultivation, many producers are turning to CEA systems. Greenhouse-grown 

peppers offer significant advantages in terms of yield stability, pest control, and year-round 

production. These systems allow for precise management of irrigation, light, and nutrients, 

resulting in higher productivity per unit area (Gómez et al. 2019). Production of sweet peppers in 

controlled environments is especially prevalent in arid and semi-arid regions such as the 

southwestern US, where protected cultivation allows for improved water use efficiency and 

climate control (Hadad et al. 2020). In addition, research into vertical farming and LED lighting 

systems are being tested for indoor pepper production to further minimize land use and resource 

inputs (Dou and Niu 2020). Due to the high initial cost of CEA facilities, pepper production in 

the US remains limited. However, as CEA technologies continue to advance and become more 
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affordable, the supply of high valued peppers via controlled environment production is expected 

to increase in order to meet the domestic demand (Berholtz et al. 2023; Gómez et al. 2019). 
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Table 1. List of reported causation factors resulting in intumescence injury including the plant family and species investigated, 

alternative terms used in reference to intumescence development, and lesion location. Adapted from Pinkard et al. 2006 and Sita 2024. 

 

Causation Factor Family  Species  Lesion Name Lesion Location  
Mechanical injury Asteraceae Hieracium venosum L. Intumescence  – 

  Brassicaceae Brassica oleracea capitata L.  Intumescence  Leaf 
  Brassicaceae Brassica oleracea capitata Intumescence  Leaf 

     

Chemical injury Brassicaceae Brassica oleracea botrytis Intumescence  Leaf 
  Euphorbiaceae Ricinus communis L. Tumor Stem 

  Solanaceae Solanum tuberosum Warts, Intumescence, Lesion Leaf, Stem 

      

Nutrient status Geraniaceae Pelargonium hortorum Ait. Oedema Leaf, Petioles 

  Salicaceae Populus spp. Intumescence Leaf 
  Solanaceae Solanum tuberosum Warts, Intumescence, Lesion Leaf, Stem 

     

Hormones (including ethylene) Salicaceae Populus grandidentata Bull Intumescence Leaf 
  Salicaceae Populus tremuloides Michx. Intumescence Leaf 
  Solanaceae Solanum tuberosum Warts, Intumescence, Lesion Leaf, Stem 

  Solanaceae Lycopersicon hirsutum Humb. 
and Ponpl. 

Neoplasm, Tumor Leaf, Stem 

     

Genetics Geraniaceae Pelargonium hortorum L’ Her Oedema Leaf, Petioles 

  Solanaceae Lycopersicon hirsutum Neoplasm, Tumor Leaf, Stem 

  Solanaceae Solanum melongena L. Oedema Leaf, Petioles 

     

Insect injury Caryophyllaceae Dianthus sp. Oedema Leaf 
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 Myrtaceae Eucalyptus regnans F. Muell Intumescence Leaf 
  Salicaceae Populus tremula L. Intumescence Leaf 

     

Air quality and airborne 
factor(s) 

Myrtaceae Eucalyptus spp. Intumescence Leaf 
Salicaceae Populus spp. Intumescence Leaf 

  Solanaceae Lycopersicon sp. Oedema, Tumor, Neoplasm, 
Intumescence 

Leaf 

  Solanaceae Lycopersicon spp. Oedema, Tumor, Neoplasm, 
Intumescence 

Leaf 

  Solanaceae Solanum tuberosum Warts, Intumescence, Lesion Leaf, Stem 

     

Light quality Malvaceae Hibiscus vitifolius L. Intumescence Fruit, Flower 
sepals, Leaf, 
Petioles, Stem 

  Solanaceae Solanum sp. Oedema, Tumor, Neoplasm, 
Intumescence 

Leaf, Petioles, 
Stem 

  Solanaceae Lycopersicon esculentum Mill. Oedema, Tumor, Neoplasm, 
Intumescence 

Leaf, Stem 

  Solanaceae Lycopersicon spp. Oedema, Tumor, Neoplasm, 
Intumescence 

Leaf 

  Solanaceae Lycopersicon hirsutum Neoplasm, Tumor Leaf, Stem 

     

Light availability Geraniaceae Pelargonium xhortorum Oedema Leaf, Petioles 

 Geraniaceae Pelargonium sp. Oedema Leaf, Petioles 

 Malvaceae Hibiscus vitifolius L. Intumescence Fruit, Flower 
sepals, Leaf, 
Petioles, Stem 

 Salicaceae Populus tremula Intumescence Leaf 
  Solanaceae Lycopersicon sp. Oedema, Tumor, Neoplasm, 

Intumescence 

Leaf 

  Solanaceae Solanum tuberosum Warts, Intumescence, Lesion Leaf, Stem 
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  Vitaceae Vitis vinifera L. Intumescence Leaf 
     

Temperature Araceae Philodendron hastatum 
Schott. 

Intumescence Stem 

 Balsaminaceae Impatiens fulva Nutt. Intumescence  – 

 Brassicaceae Brassica oleracea capitata Intumescence  Leaf 
  Geraniaceae Pelargonium xhortorum Oedema Leaf, Petioles 

  Malvaceae Hibiscus vitifolius Intumescence Fruit, Flower 
sepals, Leaf, 
Petioles, Stem 

  Moraceae Ficus elastica Roxb. Intumescence – 

  Solanaceae Lycopersicon sp. Oedema, Tumor, Neoplasm, 
Intumescence 

Leaf 

 Solanaceae Solanum melongena L. Oedema Leaf, Petioles 

  Solanaceae Solanum sp. Oedema, Tumor, Neoplasm, 
Intumescence 

Leaf, Petioles, 
Stem 

     

Excess water/humidity Acanthaceae Aphelandra porteana Morel Intumescence – 

 Acanthaceae Ruellia formosa Andr. Intumescence – 

 Balsaminaceae Impatiens fulva Oedema –  

  Brassicaceae Brassica oleracea capitata Intumescence  Leaf 
 Geraniaceae Pelargonium xhortorum Oedema Leaf, Petioles 

 Geraniaceae Pelargonium sp. Oedema Leaf, Petioles 

 Malvaceae Hibiscus vitifolius Intumescence Fruit, Flower 
sepals, Leaf, 
Petioles, Stem 

  Moraceae Ficus elastica Intumescence –  

 Myrtaceae Eucalyptus spp. Intumescence Leaf 
  Pinaceae Pinus virginiana Excrescences Root  
  Pinaceae Pinus sylvestris Excrescences Root  
  Pinaceae Picea rubens Excrescences Root  
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  Pinaceae Pinus rigida Excrescences Root  
  Pinaceae Pinus resinosa Excrescences Root  
  Pinaceae Pinus ponderosa Excrescences Root, Stem 

  Salicaceae Populus grandidentata  Intumescence Leaf 
  Salicaceae Populus spp. Intumescence Leaf 
 Solanaceae Lycopersicon sp. Oedema, Tumor, Neoplasm, 

Intumescence 
Leaf 

  Solanaceae Solanum melongena Oedema Leaf, Petioles 

 Solanaceae Solanum tuberosum Warts, Intumescence, Lesion Leaf, Stem 

     

Other unknown causative 
factors 

Fabaceae Phaseolus vulgaris Intumescence  Stem 

Fabaceae Senna multiglandulosa  Intumescence   – 

  Fabaceae Cassia floribunda Intumescence   – 

  Fabaceae Vicia faba Intumescence  Pods 

  Fabaceae Pisum sativum Intumescence, Tumor  Pods 

  Fabaceae Vigna unguiculata L. Walp. Edema Leaf 
  Pinaceae Pinus coulteri Excrescences Root  
  Pinaceae Pinus banksiana Excrescences Root  
  Pinaceae Pinus caribaea Excrescences Root  
  Pinaceae Pinus strobus Excrescences Root  
  Pinaceae Pinus monticola Excrescences Root  
  Pinaceae Pinus excelsa Excrescences Root  
  Pinaceae Picea canadensis Excrescences Root  
  Pinaceae Picea mariana Excrescences Root  
  Pinaceae Picea pungens Excrescences Root  
  Pinaceae Abies balsamea Excrescences  – 
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CHAPTER 2. CHARACTERIZATION AND TIMING OF LEAF EXPANSION FOR 
THREE CAPSICUM ANNUUM CULTIVARS 

 

 
 

2.1 Abstract 

Intumescence is a physiological disorder affecting many plant species grown in 

controlled environments. Intumescence is characterized by unrestricted cellular elongation 

causing protruding lesions, ultimately leading to epidermal rupture. The impacts of this disorder 

to the industry involve reduced yield, loss of productivity, and reduced ornamental value. 

Intumescence has been studied for over 140 years, but the mechanism of action and 

developmental stages are still not well understood. This study was conducted to determine the 

timing of leaf area expansion in pepper (Capsicum annuum) to better inform mitigation strategies 

for intumescence development. Three industry relevant pepper cultivars, ‘Pot-a-Peño’, ‘Spicy 

Jane’, and ‘California Wonder’ were transplanted into 15-cm pots and grown in a common 

greenhouse environment. Upon initiating the experiment, one uniform, newly developed leaf 

from each plant was tagged and photos were collected twice daily (0700 and 1900 HR) for 7 d. 

Image analysis was conducted using ImageJ and anatomical measurements such as area, 

perimeter, width, and length were recorded. Generally, leaf area expansion was greatest during 

the night compared to the day for all three cultivars. For example, average leaf expansion over 

the course of the 7d data collection period was 46%, 34%, and 94% greater during the night 

compared to the day for ‘Spicy Jane’, ‘Pot-a-Peño’, and ‘California Wonder’, respectively. These 

results will help in the prediction of intumescence development and informing decisions and 

techniques for suppression of this disorder. 
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2.2 Introduction  

Pepper (Capsicum annuum) consumption is increasing across the US; this includes both 

hot and bell pepper varieties. For example, the consumption per capita of hot peppers rose from 

three pounds in 1980 to over seven pounds in 2020 (Lillywhite and Tso 2021). Despite the 

growing consumer demand, nearly 87% of peppers are currently imported from Mexico to the 

US (Biswas et al. 2018). Peppers are considered a high value crop within controlled environment 

agriculture (CEA) and can provide an opportunity for domestic growers to expand into a high 

demand niche market. CEA can provide significant advantages to pepper production by 

facilitating year-round production, targeted pest control, and stable yields (Kim 2016). These 

systems provide precise management of irrigation and nutrition, lighting applications, and 

temperature control, resulting in higher productivity per area (Gòmez et al. 2019). However, 

CEA does face challenges including the amplification of some disorders compared to 

conventional farming due to the closed nature of controlled environments (Singh et al. 2020). 

Previous research on crops grown in controlled environments, particularly solanaceous species, 

has noted common disorders such as fruit cracking, curved fruit, blossom end rot, and 

intumescence (Savvas et al. 2008; Sorauer 1922). Intumescence, like other disorders previously 

mentioned, can substantially reduce the marketable value of the affected crop. 

Intumescence is a physiological disorder characterized by the unregulated elongation and 

expansion of spongy mesophyll and parenchyma cells (Lang and Tibits 1983; Williams 2016). 

Normal cellular elongation is part of an essential biological process that enables the plant to 

grow in shape and size (Hart 1988). As leaves grow, the dynamic interplay of turgor pressure, 

cell wall loosening, and environmental conditions such as light and humidity plays a role in 

determining both the rate and extent of expansion (Kirkham 2014; Oguchi et al. 2018). However, 
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these processes can become dysregulated, possibly resulting in intumescence development. 

Recent investigations have highlighted the susceptibility of rapidly expanding leaf tissues to 

intumescence, suggesting a close relationship between the physiological regulation of leaf 

growth and the onset of this disorder (Miyama and Yasui 2021; Suzuki et al. 2020). For example, 

rapid cellular expansion in young tomato (Solanum lycopersicum) (Suzuki et al. 2020) and 

pepper (Hoffmann et al. 2015) leaves under high humidity or suboptimal light conditions may 

disrupt normal cell wall formation and promote cellular rupture or proliferation. Pantin et al. 

(2011) described leaf expansion as being controlled by either metabolic or hydraulic regulation 

and suggested that the expansion predominantly occurs during the night when transpiration is 

low and turgor pressure can be maintained. In a greenhouse study analyzing leaf growth of 

soybean (Glycine max ‘Gallec’), Mielewczik et al. (2013) found that maximal growth was 

observed at night compared to the day. This response is further supported by Volkenburgh 

(1999) who emphasized that leaf expansion often peaks during the night due to favorable water 

balances. Miyama and Yasui (2021) conducted research using tomato cultivars ‘Momotaro 

Peace’, ‘CF House Momotaro’, and ‘Reiyo’ which supports the possibility of intumescence 

development corresponding with large changes in water potential. Their results found if ambient 

humidity and soil moisture increases suddenly, water absorption temporarily exceeded the 

transpiration rate, resulting in cellular rupture in all three cultivars (Miyama and Yasui 2021). 

Water status plays an essential role in the development and expansion of leaves; this delicate 

balance can be disrupted leading to morphological changes and intumescence development in 

newly expanding leaves.   

In attempts to mitigate intumescence development, previous research has suggested using 

end-of-day (EOD) lighting applications (Eguchi et al. 2016a; Eguchi et al. 2016b). Currently, the 
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use of EOD lighting includes specific spectra of light to manipulate physiological or 

morphological traits based on the desired outcomes (e.g., compactness, breaking dormancy, 

flower regulation) (Lopez and Runkle 2017). Since EOD lighting applications have been found 

to alter leaf morphology, it may be crucial to coincide EOD lighting with leaf expansion in order 

to suppress intumescence development. 

To better understand the timing of intumescence development, identifying when spongy 

mesophyll and parenchyma cells elongate and expand to drive leaf expansion in pepper is 

crucial. The objective of this experiment was to determine the timing of accelerated cellular 

expansion in pepper leaves by comparing leaf expansion rates occurring during the day and 

night. This study was intended to inform potential intumescence mitigation strategies for pepper 

production in CEA. We hypothesize that pepper leaves will have a higher rate of expansion 

during the night compared to the day based on previous research. 

2.3 Materials and Methods 

2.3.1 Plant Materials and Greenhouse Environment 

Pepper cultivars ‘Pot-a-Peño’, ‘Spicy Jane’, and ‘California Wonder’ were evaluated 

during the summer of 2024 based on their susceptibility to intumescence development. On 11 

July 2024, seeds were sown into 128-cell trays using commercial soilless germination media 

(Berger BM2 Seed Germination; Berger, Saint-Modeste, Quebec City, CA) and covered lightly 

with vermiculite (Sun Gro® Horticultural Vermiculite Premium Grade Medium A-2 Coarse; Sun 

Gro®, Agawam, MA, USA). Trays were fertigated daily using Jack’s water-soluble fertilizer 

(Jack’s 13N–0.9P–10.8K Plug LX; J.R. Peters, Inc., Allentown, PA, USA) providing 75 mg·L–1 

nitrogen. pH and electrical conductivity (EC) of the fertilizer solution were confirmed using a 

handheld meter (Bluelab Combo Meter, Bluelab, Tauranga, New Zealand). Trays were 
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germinated under fitted plastic domes for two weeks. Upon germination, humidity domes were 

removed. Seedlings were transplanted into 15-cm plastic pots on 1 Aug 2024. Transplants were 

fertigated every other day using a water-soluble fertilizer (Jack’s 21N–2.2P–16.7K; J.R. Peters, 

Inc., Allentown, PA, USA) providing 150 mg·L–1 nitrogen per industry recommendation. Seed 

trays and transplants were grown and maintained in a greenhouse located at the Colorado State 

University Horticulture Center in Fort Collins, CO, USA. Greenhouse environmental conditions 

were controlled using a VeriStep dynamic control system (Wadsworth Control System, Arvada, 

CO, USA) with a temperature set point of 25/18 °C (day/night). Air temperature, relative 

humidity (RH), photosynthetic photon flux density (PPFD), and carbon dioxide (CO2) 

concentration were monitored and logged every 10 min using an aspirated datalogger (Guardian 

SM-600; Apogee® Instruments, Logan, UT, USA), with average values reported in Table 2. Two 

replicates of five plants per cultivar (N=10) were conducted simultaneously, blocked by bench 

located within the same greenhouse. Within each bench, plant positions were randomly rotated 

daily to ensure uniformity. 

2.3.2 Data Collection 

On 16 Aug 2024, one uniform leaf (no less than 2 cm in length) at the 4th node of the 

apical meristem, measured from the base, was tagged on each plant for imaging. Nondestructive 

imaging started on 20 Aug 2024 and ended the morning of 27 Aug 2024. Five plants from each 

species per replication were observed twice daily (0700 and 1900 HR) for 7 d, with photos of the 

adaxial surface of tagged leaves collected during each observation using a digital camera 

(Hero12 Black; GoPro, San Mateo, CA, USA) affixed with a 15X lens (15X Macro Lens; 

QKOO, China) connected to a 15 cm  23 cm white clipboard via a gooseneck clamp (Suptig 

Jaws Flex Clamp Gooseneck Mount; Suptig, Shenzhen, China) to maintain a fixed position. To 
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gently secure the leaf in a fixed position, a clear sleeve (73  122 mm matte sleeve; GameGenic 

Ingenious Supplies, Essen, Germany) was affixed to the clipboard. The camera lens was centered 

upon the middle of the card sleeve and positioned 15 cm from the clipboard surface. Photos were 

analyzed using ImageJ software (US National Institutes of Health, Bethesda, MD, USA) to 

determine leaf length (cm), width (cm), perimeter (cm), and area (cm2). Calculations to 

determine change in leaf area expansion occurring during the day (Daytime; DT) were conducted 

by deducting the current days PM values from the AM values (e.g., PMDay1 – AMDay1= DT 1), 

while change in leaf area expansion occurring during the night (Nighttime; NT) was calculated 

by deducting the current days AM value from the previous day’s PM value (e.g., AMDay2 – 

PMDay1 = NT 1). For a detailed description of image capture and processing, see Appendix A. 

2.3.3 Statistical Analysis 

The experiment was conducted using a randomized complete block design, with time of 

day (DT or NT) serving as a treatment factor, bench as a blocking variable, and plant number as 

a random variable. Data analysis for each replication was combined and represented in the data 

reported. The effects of DT and NT were compared by analysis of variance (ANOVA) with R 

and RStudio [R version 4.3 (R Core Team 2023)] as well as jamovi [jamovi version 2.6 (The 

jamovi project, 2025)], using Tukey’s honestly significant difference (HSD) test at P ≤ 0.05.  

2.4 Results  

California Wonder – While average leaf area increased consistently over the course of the 

7 d data collection period for pepper ‘California Wonder’ during both DT and NT (Fig. 1), leaf 

area expansion was generally greater during NT compared to DT (Fig. 2). Specifically, leaf area 

expansion during NT was greater than DT on days 1-4. While results were not significant, leaf 

area expansion was also greater during NT compared to DT on days 5 (P = 0.052) and 6 (P = 
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0.425). Similarly, average leaf length, width, perimeter, and area over the 7 d data collection 

period was greatest during NT compared to DT (Table 3). For example, average leaf area 

expansion for ‘California Wonder’ was 94% greater during NT compared to DT over the 7 d data 

collection period.  

Pot-a-Peño – Similarly, average leaf area increased consistently over the duration of the 7 

d data collection period for ‘Pot-a-Peño’ during both DT and NT (Fig. 3), with leaf area 

expansion being greater during the NT compared to DT (Fig. 4). Specifically, leaf area 

expansion during the NT was greater than DT on days 3 and 4 (Fig. 4). While results were not 

significant, leaf area expansion was also greater during the NT compared to DT on days 1 (P = 

0.069), 2 (P = 0.262), 5 (P = 0.066), and 6 (P = 0.125). Similarly, average leaf length, width, 

perimeter, and area for the 7 d data collection period were greatest during the NT compared to 

DT (Table 3). For example, average leaf area expansion for ‘Pot-a-Peño’ was 34% greater during 

the NT compared to DT over the 7 d data collection period.   

Spicy Jane – Consistent with the other two cultivars, ‘Spicy Jane’ leaf area increased 

consistently throughout the 7 d data collection period for during both DT and NT (Fig. 5), with 

the greatest leaf area expansion occurring predominantly during the NT compared to DT (Fig. 6). 

Specifically leaf area expansion during the NT was greater than DT on days 1, 3, 4, and 5 (Fig. 

6). Although results were not significant, leaf area expansion was also greater on days 2 (P = 

0.136), and 6 (P = 0.724). Similarly, average leaf length, width, perimeter, and area for the 7 d 

data collection period were greatest during the NT compared to DT (Table 3). For example, 

average leaf area expansion for ‘Spicy Jane’ was 46% greater during the NT compared to the DT 

over the 7 d data collection period. 
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2.5 Discussion 

Although there is much debate over causative factors, intumescence development is 

consistently observed on rapidly expanding leaves. Leaf expansion is a continual process until 

the leaf reaches a mature state; as the leaf reaches maturity, the growth rate slows or even stops, 

which could help to explain why rapidly expanding leaves have been shown most susceptible to 

intumescence development while mature leaves are generally free from symptoms (Eisa and 

Dobrenz 1971). Suzuki’s (2020) research with tomato ‘CF Rinka 409’ found intumescence 

injury had the highest severity in developing leaves, low severity in fully developed leaves, and 

little to no development in young leaves with slower rates of expansion. La Rue (1933) found 

similar results while researching intumescence development on poplar leaves, observing very 

young leaves did not show any susceptibility to intumescence development until reaching about 

half their final mature size. Due to leaf maturity being a seemingly important factor in 

susceptibility to intumescence development, immature rapidly expanding leaves were chosen to 

be tagged for image analysis and development observations in the present study.  

Leaf expansion in all three cultivars was greatest during NT compared to DT, with NT 

accounting for 66%, 57%, and 59% of total leaf area expansion for ‘California Wonder’, ‘Pot-a-

Peño’, and ‘Spicy Jane’, respectively. This is consistent with previous research conducted by 

Mielewczik (2013), whereby leaf expansion in soybean was evaluated using a marker-tracking 

time-lapse camera which revealed greater leaf expansion occurred during the night compared to 

the day. These results are also supported by earlier research demonstrating that both metabolic 

and hydraulic processes vary between day and night and influence growth rates, with metabolic 

control dominating in early development and hydraulic constraints becoming more pronounced 

as leaves mature (Pantin et al. 2011; Volkenburgh 1999). For example, in Arabidopsis, Pantin et 
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al. (2011) reported that metabolic-driven expansion in young leaves was most apparent at night, 

when favorable water balance supported cell enlargement. However, this nocturnal expansion 

could be limited by restricted starch reserves relative to the high carbon demand for growth. 

These authors found that as leaves continue to develop, the main constraint shifted to hydraulics, 

with reduced daytime turgor increasingly restricting expansion. This hydraulic limitation was 

associated with a reduced capacity of the leaf’s water transport system to supply growing tissues 

under conditions of high evaporative demand. At both developmental stages, nighttime 

expansion tended to be more favorable due to improved water balance, which allowed partial 

recovery from daytime turgor loss (Pantin et al. 2011).  

While not statistically analyzed, there were also clear differences in habit and leaf size 

between cultivars. The most prominent difference being that pepper ‘California Wonder’ is a bell 

pepper variety with a mounded habit while pepper ‘Pot-a-Peño’ and ‘Spicy Jane’ are both hot 

pepper varieties. Pepper ‘Pot-a-Peño’ and ‘Spicy Jane’ are bred for a compact habit and 

proliferation of smaller leaves, respectively, leading to a lower magnitude of response in terms of 

leaf area expansion. While not included in the present study, these differences between cultivars 

should be considered. 

This study confirms the timing in which pepper leaves expand, providing a basis for 

intumescence research among upcoming pepper cultivars of interest to CEA production. Since 

cellular expansion primarily occurred during NT, it is possible that this is a window of 

opportunity for the suppression of intumescence development in susceptible species. Thus, 

mitigation strategies could be timed to coincide with periods of rapid cellular expansion. 

Recognizing the timing of cellular expansion, growers can potentially expand their current use of 
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EOD or pre-dawn lighting applications to mitigate intumescence development in susceptible 

pepper cultivars.  
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Table 2. Mean  SD daily light integral (DLI), temperature, relative humidity, and CO2 

concentration across two experimental replications (benches) during the day (0700-1900 HR) and 
night (1900-0700 HR) from 20 Aug 2024 – 27 Aug 2024.  
 

DLI 

mol·m−2·d−1 

Temperature 

°C 

Humidity 

% 

CO2 

μmol·mol−1 

Day  19.2  4.6 24.9  0.4 48.5  3.5 475.3  5.2 

Night  − 22.3  1.0 51.1  8.3   502.6  10.2 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  



 

 40 

Table 3. Least square means of daily leaf area, length, width, and perimeter during the daytime 
(DT; 0700 – 1900 HR) and nighttime (NT; 1900 – 0700 HR) for individual leaves of pepper 
(Capsicum annuum) ‘California Wonder’, ‘Pot-a-Peño’, and ‘Spicy Jane’ collected over a 7 d 
data collection period from 20 Aug 2024 – 27 Aug 2024 for two experiment replicates (N = 10).  

 
Area 
(cm2) 

Length 
(cm) 

Width 
(cm) 

Perimeter 
(cm) 

 

California Wonder 
  

 
 

DT 4.68z 0.51 0.39 1.49 

NT 9.07 1.01 0.61 2.80 

Sig. ***y *** ** *** 
   

 
 

Pot-a-Peño 
  

 
 

DT 2.27 0.40 0.22 1.04 

NT 3.04 0.59 0.27 1.40 

Sig. NS * NS NS 
   

 
 

Spicy Jane 
  

 
 

DT 1.40 0.31 0.16 0.78 

NT 2.04 0.42 0.20 1.06 

Sig. ** NS NS NS 

zMean values are based on single leaves selected from ten plants across two experimental 

replications.  

yNS, *, **, *** indicate non-significance or significance between DT and NT within a cultivar at 

P ≤ 0.05, 0.01, and 0.001, respectively.    
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Figure 1. Imaged leaf area for individual leaves of pepper (Capsicum annuum) ‘California 
Wonder’ measured daily over a 7 d data collection period for two experiment replicates (N = 10). 
Values represent the average leaf area for plants measured during the daytime (0700-1900 HR) 
in orange circles and nighttime (1900-0700 HR) in blue circles. Error bars indicate ± standard 
error of the mean.  
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Figure 2. Calculated leaf area difference (cm2) of individual imaged leaves to determine change 
in leaf area expansion occurring during the day (Daytime; DT) (0700-1900 HR, in orange 
circles) and night (Nighttime; NT) (1900-0700 HR, in blue circles) for pepper (Capsicum 
annuum) ‘California Wonder’ on specific dates throughout a 7 d data collection period for two 
experiment replicates (N = 10). Daytime leaf area difference was calculated by deducting the 

current days PM values from the AM values (e.g., PMDay1 – AMDay1= DT 1), while nighttime 
leaf area difference was calculated by deducting the current days AM value from the previous 
day’s PM value (e.g., AMDay2 – PMDay1 = NT 1). Error bars indicate ± standard error of the 
mean, with *, **, *** indicating significance at P ≤ 0.05, 0.01, and 0.001, respectively, between 
day and night for the specified date intervals.    
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Figure 3. Imaged leaf area for individual leaves of pepper (Capsicum annuum) ‘Pot-a-Peño’ 
measured daily over a 7 d data collection period for two experiment replicates (N = 10). Values 
represent the average leaf area for plants measured during the daytime (0700-1900 HR) in orange 
circles and nighttime (1900-0700 HR) in blue circles. Error bars indicate ± standard error of the 
mean.  
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Figure 4. Calculated leaf area difference (cm2) of individual imaged leaves to determine change 

in leaf area expansion occurring during the day (Daytime; DT) (0700-1900 HR, in orange 
circles) and night (Nighttime; NT) (1900-0700 HR, in blue circles) for pepper (Capsicum 

annuum) ‘Pot-a-Peño’ on specific dates throughout a 7 d data collection period for two 
experiment replicates (N = 10). Day leaf area difference was calculated by deducting the current 
days PM values from the AM values (e.g., PMDay1 – AMDay1= DT 1), while night leaf area 

difference was calculated by deducting the current days AM value from the previous day’s PM 
value (e.g., AMDay2 – PMDay1 = NT 1). Error bars indicate ± standard error of the mean, with 
*, **, *** indicating significance at P ≤ 0.05, 0.01, and 0.001, respectively, between day and 
night for the specified date intervals. 
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Figure 5. Imaged leaf area for individual leaves of pepper (Capsicum annuum) ‘Spicy Jane’ 
measured daily over a 7 d data collection period for two experiment replicates (N = 10). Values 
represent the average leaf area for plants measured during the daytime (0700-1900 HR) in orange 
circles and nighttime (1900-0700 HR) in blue circles. Error bars indicate ± standard error of the 
mean.  
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Figure 6. Calculated leaf area difference (cm2) of individual imaged leaves to determine change 
in leaf area expansion occurring during the day (Daytime; DT) (0700-1900 HR, in orange 

circles) and night (Nighttime; NT) (1900-0700 HR, in blue circles) for pepper (Capsicum 

annuum) ‘Spicy Jane’ on specific dates throughout a 7 d data collection period for two 
experiment replicates (N = 10). Day leaf area difference was calculated by deducting the current 
days PM values from the AM values (e.g., PMDay1 – AMDay1= DT 1), while night leaf area 
difference was calculated by deducting the current days AM value from the previous day’s PM 
value (e.g., AMDay2 – PMDay1 = NT 1). Error bars indicate ± standard error of the mean, with 
*, **, *** indicating significance at P ≤ 0.05, 0.01, and 0.001, respectively, between day and 
night for the specified date intervals. 
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CHAPTER 3: THE EFFECT OF END-OF-DAY AND PRE-DAWN LIGHTING STRATEGIES 

ON MORPHOLOGY AND INTUMESCENCE DEVELOPMENT FOR THREE CAPSICUM 

ANNUUM CULTIVARS 

 
 

 

3.1 Abstract 

Intumescence is a physiological disorder characterized by hypertrophy and hyperplasia of 

epidermal and palisade parenchyma cells occurring on leaves, petioles, and stems of multiple 

plant species. Whether blue, far-red, or ultraviolet light are implicated, end-of-day (EOD) 

lighting strategies have been proven effective at controlling intumescence. Especially for 

emerging crops with limited research on production strategies (e.g., pepper), EOD lighting is a 

potentially cost-effective means to control intumescence, which may otherwise limit adaptability 

of these crops for controlled-environment production systems. With the use of low-intensity 

EOD and pre-dawn (PD) LED lighting applications as a means of providing a cost-effective 

option to alleviate crop losses from intumescence injury in susceptible pepper cultivars, this 

study was aimed at characterizing morphological changes occurring during EOD or PD light 

treatments. Three pepper (Capsicum annuum) cultivars ‘California Wonder’, ‘Pot-a-Peño’, and 

‘Spicy Jane’ were all grown in a common greenhouse setting. Five plants from each cultivar 

were allocated to one of four light treatments, comprised of three EOD treatments consisting of 

blue (EODB), red (EODR) and far-red light (EODFR) as well as one pre-dawn blue light treatment 

(PDB). Plants in each lighting treatment were subjected to a 30-minute duration at an intensity of 

~25 µmol·m·−2·s−1 supplied at either EOD or PD depending on their assigned treatment group. 

While there was no intumescence development throughout the duration of this study, there were 

changes to plant morphology. Specifically, total leaf dry mass, stem dry mass, total dry mass, 
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and compactness were all greatest for pepper ‘California Wonder’ grown under PDB. While 

peppers ‘Pot-a-Peño’ and ‘Spicy Jane’ did not have any differences in total leaf dry mass, stem 

dry mass, total dry mass, or compactness, height differences were observed whereby plants were 

taller under EODR compared to PDB. The relevance of cultivar-specific morphological responses 

to light quality should be taken into account when using either EOD or PD lighting strategies to 

mitigate intumescence injury.  

3.2 Introduction  

Plants use light as a form of energy for photosynthesis, converting water and carbon 

dioxide into sugars, but light is also used as a signal regulating morphology and physiology 

(Lopez et al. 2017). The specific wavelengths of light detected by plants that drive 

photosynthetic activity are traditionally referred to as photosynthetically active radiation (PAR; 

400-700 nm). While wavelengths outside of the PAR range [e.g., UV-A and UV-B (300-400 

nm), far-red (700-800nm)] are not generally considered photosynthetically active, they do elicit 

other plant responses including changes to plant morphology and pigmentation (Hernandez and 

Kubota 2017). In controlled environment agriculture (CEA), where electric lighting supplements 

or replaces sunlight, growers must carefully balance light spectrum, intensity, and timing to 

optimize production. The introduction of light-emitting diode (LED) technologies has 

transformed CEA production by offering spectral precision, lower energy costs, and longer 

fixture lifespans compared to traditional high-pressure sodium or fluorescent lamps (Both and 

Faust 2017; Massa et al. 2008). These innovations allow for the targeted application of blue, red, 

and far-red light to manipulate photosynthetic efficiency, plant architecture, and reproductive 

development. The growing popularity and cost reduction of tunable lighting systems and 

continuous advancements in LED technologies have allowed growers the ability to manipulate 
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the lighting environment to promote desired outcomes such as biomass accumulation (Massa et 

al. 2008) and the promotion or inhibition of flowering via photoperiod manipulation (Runkle et 

al. 2017) in ways that were not possible with earlier lighting systems. This ability to manipulate 

light quality and quantity has also revealed a possible link between the spectral environment and 

the occurrence of physiological disorders. 

One disorder of rising interest within CEA is intumescence. Intumescence is 

characterized by the hypertrophy and hyperplasia of cells, typically the palisade parenchyma and 

spongy mesophyll, which erratically elongate resulting in the rupture of the epidermal layer and 

the formation of crystalized or wart-like lesions on leaves, stems, or petioles (Sita et al. 2024; 

Sorauer 1922). These lesions reduce photosynthetic capacity resulting in reduced yield, leaf 

abscission when severe, as well as diminished marketability of ornamental crops (Sita et al. 

2024). Intumescence has been observed in many crop species grown in CEA such as tomato 

(Solanum lycopersicum), eggplant (Solanum melongena), pepper, and potato (Solanum 

tuberosum), as well as ornamental species such as cuphea (Cuphea llavea) and ornamental sweet 

potato (Ipomoea batatas) (Craver et al. 2014; Lang and Tibbits 1983; Suzuki et al. 2020). 

Observations occurring in pepper are of rising interest due to their high consumer demand and 

relatively high market value in CEA (Gómez et al. 2019). Given the increasing importance of 

pepper production in controlled environments, management strategies to reduce intumescence 

are essential for their success in CEA production.  

Greenhouse end-of-day (EOD) lighting applications are typically characterized as low-

intensity electric light provided at the end of the photoperiod and are commonly used to regulate 

flowering. Recent studies suggest that lighting strategies, particularly EOD applications, offer a 

promising tool for managing intumescence injury. Massa et al. (2008) demonstrated that 
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maintaining at least 15% blue light of total irradiation suppressed intumescence in cowpea 

(Vigna unguiculata), but lesions did develop when blue light was maintained at less than 15% 

total irradiation. Eguchi et al. (2016b) found intumescence injury was suppressed in tomato 

cultivars ‘Beaufort’ and ‘Maxifort’ when EOD far-red light was provided in addition to a sole-

source lighting environment consisting of 10% blue (400-500 nm) and 90% red (600-700 nm) 

light. Additionally, supplementation with UV-B has been shown to reduce intumescence 

development in ornamental sweetpotato ‘Ace of Spades’ and tomato ‘Beaufort’ when compared 

with plants grown under UV-B–blocking films or UV-B–deficient lighting conditions (Craver et 

al. 2014b; Kubota et al. 2017). In greenhouse production where ambient solar radiation cannot be 

easily controlled and often diminishes spectral manipulation via LEDs, EOD light strategies are a 

practical means to modify plant responses by providing a targeted light spectra when solar 

radiation is no longer a factor. Thus, EOD lighting presents the potential for growers to apply 

low-intensity spectral treatments at specific times of day to mitigate intumescence injury without 

significantly altering energy costs. 

However, designing effective EOD lighting strategies is essential as these applications 

often influence plant morphology through a variety of photoreceptor proteins. For example, red 

and far-red light regulate the active and inactive forms of phytochromes, which in turn controls 

shade avoidance responses typically associated with stem elongation and leaf expansion 

(Hernandez and Kubota 2017). The use of EOD far-red lighting in CEA has been successful in 

manipulating plant morphology, including the induction of increased hypocotyl elongation in 

tomato rootstock for grafting purposes (Chia and Kubota 2010). Specifically, Chia and Kubota 

(2010) found that EOD lighting with a low ratio of red to far-red light (R:FR) enhanced 

hypocotyl elongation in tomato rootstock seedlings ‘Aloha’ and ‘Maxifort’ as compared to a 
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control receiving no EOD far-red lighting. On the other hand, blue light can be perceived by 

cryptochromes, which play a role in regulating stomatal function, leaf thickness, restriction of 

cellular expansion at high intensities, de-etiolation, and circadian oscillation (Dou and Niu 2020; 

Massa et al. 2008). These responses are highly dynamic and sensitive to both spectrum and 

timing; thus, manipulating the light environment at either EOD or pre-dawn (PD) may offer 

pepper producers a means to suppress physiological disorders, such as intumescence, while also 

providing lighting inputs to manipulate crop architecture, flowering, and yield positively. While 

further research is needed, EOD lighting provides a valuable tool for both scientific and 

commercial applications.  

Although pepper is an important global crop, its cultivation in controlled environments is 

limited by challenges such as intumescence injury and variable morphological responses to 

lighting strategies (Cope et al. 2014; Hernandez and Kubota 2017). Therefore, the objective of 

this experiment was to quantify the effects of low-intensity, monochromatic EOD and PD 

lighting applications on the morphology and intumescence development of three commercially 

relevant pepper cultivars ‘California Wonder’, ‘Pot-a-Peño’, and ‘Spicy Jane’. By quantifying 

changes in leaf morphology, this research aims to identify a cost-effective lighting strategy that 

incorporates both appropriate spectrum and timing to reduce the incidence of intumescence 

injury while maintaining desirable growth characteristics for CEA pepper production.  

3.3 Materials and Methods  

3.3.1 Plant Materials and Greenhouse Environment 

Seeds of hot pepper cultivars ‘Pot-a-Peño’ and ‘Spicy Jane’ and bell pepper cultivar 

‘California Wonder’ were sown on 11 July 2024 in 128-cell trays using a commercial soilless 

germination media (Berger BM2 Seed Germination; Berger; Saint-Modeste, Quebec City, CA), 
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then covered lightly with vermiculite (Sun Gro® Horticultural Vermiculite Premium Grade 

Medium A-2 Coarse;. Sun Gro®, Agawam, Massachusetts, USA) and placed under fitted plastic 

domes for two weeks until germination occurred. Seedling trays were irrigated daily using Jack’s 

water-soluble fertilizer (Jack’s 13N–0.9P–10.8K Plug LX; J.R. Peters, Inc., Allentown, PA) 

supplying 75 mg·L–1 N. The water-soluble nutrient concentration as well as pH and electrical 

conductivity (EC) were monitored using a handheld pH/EC meter (Bluelab Combo Meter; 

Bluelab, Tauranga, New Zealand). Seedlings were transplanted into 15-cm standard plastic pots 

on 1 Aug 2024 and were irrigated as needed using a water-soluble fertilizer (Jack’s 21N–2.2P–

16.7K; J.R. Peters, Inc., Allentown, PA) supplying 150 mg·L–1 N. All stages of pepper 

production were conducted in a greenhouse located at the Colorado State University Horticulture 

Center located in Fort Collins, CO, USA. Greenhouse environmental conditions were controlled 

and monitored using a VeriStep dynamic control system (Wadsworth Control System, Arvada, 

CO, USA) with a day/night temperature setpoint of 25/21 °C. Air temperature (°C), relative 

humidity (RH), photosynthetic photon flux density (PPFD), and carbon dioxide (CO2) 

concentration were monitored using aspirated dataloggers (Guardian SM-600; Apogee® 

Instruments, Logan, Utah, USA), with data reported in Table 4.  

3.3.2 Lighting Treatments 

Beginning on 22 August 2024, five plants from each cultivar were subjected to one of 

four 30-minute lighting treatments at an intensity of 25 μmol·m−2·s−1 for two weeks provided at 

either EOD (2030 HR) with blue (EODB; peak of 447 nm), red (EODR; peak of 659 nm), or far-

red light (EODFR; peak of 734 nm), or pre-dawn (PD; 0500 HR) with blue light (PDB; peak of 

447 nm). All lighting treatments were provided by tunable LED fixtures (Elixia; Heliospectra, 

Gothenburg, Sweden) suspended ~1 m above 1 × 1.5 m bench sections in the greenhouse 
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surrounded by opaque polyethylene sheeting to prevent light contamination from adjacent 

treatments. For EOD treatment applications, plants were moved under the appropriate tunable 

LED fixture at ~2015 HR and returned to a randomized bench location in the greenhouse at 

~2100 HR. For the PD treatment applications, plants were moved at ~2100 HR and returned to a 

randomized bench location in the greenhouse the following morning at ~0700 HR. Light 

intensity was measured at the beginning of the experiment at canopy height using a handheld 

spectrometer (MS-100; Apogee® Instruments, Logan, Utah, USA), with average ± SD for each 

treatment reported in Table 5. 

3.3.3 Leaf Imaging 

Leaf imaging was conducted prior to treatment initiation (Day 0) and subsequently on 

Days 7 and 14 at ~0900 HR using a digital camera (Hero12 Black; GoPro, San Mateo, 

California, USA) affixed with a 15X lens (15X Macro Lens, QKOO, China) attached to a 15 × 

23 cm white clipboard via a preconfigured gooseneck clamp (Suptig Jaws Flex Clamp 

Gooseneck Mount; Suptig, Shenzhen, China) to maintain a fixed position. For each plant, one 

uniform leaf at the 4th node of the apical meristem was tagged (no less than 2 cm in length) for 

imaging of the adaxial leaf surface to evaluate changes in leaf area in response to EOD and PD 

treatments. The tagged leaf was gently secured in a fixed position on the clipboard via a clear 

sleeve (73  122 mm matte sleeve; GameGenic Ingenious Supplies, Essen, Germany). The 

camera lens was centered upon the middle of the card sleeve and positioned 15 cm above the 

clipboard surface. Image analysis of photographed leaves was conducted using ImageJ software 

(ImageJ, US National Institutes of Health, Bethesda, Maryland, USA), the same image 

processing steps outlined in Chapter 2 and the Appendix were utilized for this experiment. 

Calculations to determine weekly changes in imaged leaf area expansion (ILAE) were calculated 
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by deducting Day 0 from Day 7 values (Day7 – Day0 = LAE7) or from Day 14 values (Day14 – 

Day0 = LAE14).  

3.3.4 Destructive Data Collection 

 Destructive data collection for all plants occurred on 6 Sep 2024. Data collection 

included recording plant height measured from the base of the plant at soil level to the highest 

point of the apical meristem. Tagged leaves were imaged before being removed at the node. The 

remaining leaves were removed at the node to be counted as well as flowers and developing fruit 

were removed and counts were recorded. Tagged leaves, stems, and non-tagged leaves of each 

plant were separated and dried at 70 °C to determine the dry mass of each using an analytical 

microbalance (Analytical Balance ME54E; Mettler Toledo Ltd, Columbus, OH, USA). Imaged 

leaf mass area was determined by dividing the individual leaf dry mass by the imaged leaf area 

(ILMA; mg·cm−2). Calculations to determine plant compactness were calculated by dividing 

stem dry mass by plant height (g·cm−1). 

3.3.5 Statistical Analysis 

The experiment was conducted using a randomized complete block design, with lighting 

treatments serving as factors and bench as a blocking variable. Replications were combined in 

the analysis, and effects of lighting treatment were compared by analysis of variance (ANOVA) 

with R and RStudio [(Version 4.3) (R Core Team 2023)] as well as jamovi [jamovi version 2.6 

(The jamovi project, 2025)], with pairwise comparisons conducted using Tukey’s honestly 

significant difference (HSD) test at P ≤ 0.05.  
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3.4 Results  

No incidence of intumescence was observed for any of the cultivars under the lighting 

treatments provided.Thus, the focus of the results will be on the morphological impacts of EOD 

and PD lighting strategies. 

California Wonder –  

 No differences were observed for Week 1 (data not shown) or Week 2 ILAE for 

‘California Wonder’ (Fig. 7). Similarly, no difference in plant height or ILMA were observed 

(Table 6). TLDM, SDM, TDM, and compactness were all greatest for ‘California Wonder’ 

grown under PDB (Table 6). For example, TLDM was 26% and 21% greater under PDB 

compared to EODFR and EODB, respectively. Similarly, compactness was 37% and 41% greater 

under PDB compared to EODFR and EODB, respectively (Table 6). While no difference in 

number of flowers was observed for ‘California Wonder’, plants grown under PDB produced the 

greatest number of fruits (Table 6). 

Pot-a-Peño – 

No differences were observed for Week 1 (data not shown) or Week 2 ILAE for ‘Pot-a-

Peño’ (Fig. 8). Additionally, no difference in TLDM, SDM, TDM, compactness, or ILMA were 

observed (Table 6). However, height was greatest for Pot-a-Peño’ under EODR, with an 11% 

increase compared to PDB (Table 6). While no difference in the number of flowers was observed 

between treatments for Pot-a-Peño, plants grown under EODB produced the greatest number of 

fruits (Table 6). 

Spicy Jane - 

Similar to ‘California Wonder’ and ‘Pot-a-Peño’, no differences were observed for Week 

1 (data not shown) or Week 2 ILAE for ‘Spicy Jane’ (Fig. 9). TLDM, SDM, TDM, compactness, 
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and ILMA were also similar across lighting treatments (Table 6). Plant height for ‘Pot-a-Peño 

was greatest under EODR, with a 9% increase compared to PDB (Table 6). No difference in the 

number of flowers or fruits between lighting treatments was observed for ‘Spicy Jane’ (Table 6).  

3.5 Discussion 

Typical responses to red and far-red light include increased stem elongation and leaf 

expansion, thinner leaves, and biomass accumulation, as well as playing key roles in flowering 

regulation, dormancy, and seed germination (Hernandez and Kubota 2017). Benefits to using 

EODFR are currently being implemented in CEA; for example, increasing stem elongation in cut 

flower production of chrysanthemums (Chrysanthemum indicum) and hypocotyl elongation of 

tomato rootstock (Hernandez and Kubota 2017). In terms of leaf expansion, increased 

percentages of far-red light in particular result in increases for many species, such as tomato and 

lettuce, by influencing a specific phytochrome-mediated response termed ‘shade avoidance’ 

(Casal 2013; Hernandez and Kubota 2017). However, no differences in ILAE were observed for 

any of the three cultivars in the present study. The lack of differences could be influenced by the 

duration of this study being limited to two weeks. However, with the primary focus for this 

experiment being the active development of individual pepper leaves, the shorter duration was 

appropriate. While results were not significant, ILAE was greatest under EODFR for ‘Spicy 

Jane’, which would be expected based on typical responses to far-red light as a signal for shade 

avoidance (Fig. 9).  

On the contrary, while results were not significant, ILAE was greatest under EODB and 

PDB for ‘California Wonder’ and ‘Pot-a-Peño’, respectively (Fig. 7 and 8). Typical plant 

responses to blue light include de-etiolation, restriction of cellular expansion, circadian 

oscillation, and flowering (Cope et al. 2014; Hernandez and Kubota 2017). Blue light can also 
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stimulate cellular expansion and cell division in the mesophyll tissues resulting in thicker leaves 

(Dou and Niu 2020). While the increase in ILAE for ‘California Wonder’ under EODB is in 

contrast to some historical expectations, this response coincides with research conducted by 

Hernandez and Kubota (2016) and Cope et al. (2014) who found that cucumber (Cucumis 

sativus) ‘Cumlaude’ and pepper ‘California Wonder’ experienced increased leaf area under 

monochromatic blue. Further, experiments conducted by Fan et al. (2013) and Cope et al. (2014) 

found that cabbage (Brassica oleracea) ‘Te Ai Wing’ and radish (Raphanus sativus) ‘Cherry 

Belle’ did not display this same leaf area increase under monochromatic blue light, supporting 

species-specific light quality responses. Cope et al. (2014) further supports these responses, as 

increased stem elongation was observed under monochromatic blue light for pepper ‘California 

Wonder’ compared to broad-spectrum light treatments. ILAE for ‘Pot-a-Peño’ being highest 

under PDB and lowest under EODB may suggest timing is critical for blue light applications for 

this cultivar. With the inconsistent responses observed with ILAE, further research is warranted 

to clarify how the timing of EOD blue light influences morphology and species-specific 

responses.   

While PDB suppressed stem elongation in all three cultivars, differences were only 

significant for ‘Pot-a-Peño’ and ‘Spicy Jane’. Blue light has been shown to suppress plant 

elongation responses. For example, Claypool and Leith (2021) found that pepper ‘Ace’ seedlings 

all displayed reduced height when grown under a spectrum containing blue light compared to 

seedlings grown without the inclusion of these wavelengths. Conversely, previous research by 

Cope et al. (2014) found that stem length increased alongside an increasing percentage of blue 

light (12-92%) for pepper ‘California Wonder’. A key difference is the use of EOD lighting in a 

greenhouse for the present study while Cope et al. (2014) conducted experiments in growth 
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chambers using sole-source lighting. Sole-source lighting facilitates customization of light 

quality and intensity allowing for fine-tuned manipulation of photomorphogenesis, but achieving 

the same outcome with EOD lighting in the greenhouse is much more difficult due to the 

abundance of natural light during the day masking subtle responses to EOD treatments (if 

applied prior to the end of the photoperiod) as well as general use of low intensities for EOD 

applications (Percival and Craver 2023). Similarly, compactness was greatest for plants grown 

under PDB, but only for ‘California Wonder’. Similar trends for ‘California Wonder’ were 

observed regarding biomass accumulation (TLDM, SDM, and TDM) under PDB. The trends 

observed regarding PDB suggest timing is an important factor in controlling photomorphogenesis 

for these pepper cultivars. While pepper responses to EODB and PDB appear to be species-

specific, further research may illustrate applications whereby low-intensity blue light could prove 

useful as a non-chemical means of controlling elongation growth. 

EODB and PDB treatments positively impacted fruit development in ‘California Wonder’ 

and ‘Pot-a-Peño’ when compared to EODR and EODFR treatments, with EODFR resulting in the 

lowest number of fruits produced in all three cultivars. Although lighting slightly influenced fruit 

number, there were no significant differences to flower development across the three cultivars. 

Due to the limited timeframe and scope of this experiment as well as inconsistent trends across 

cultivars, further research is needed to fully understand the impacts of EOD and PD light on 

flower and fruit set for peppers.  

3.6 Conclusion 

While results from the present study suggest that EOD or PD lighting strategies may 

assist in promoting desirable photomorphogenic traits, such as increased compactness, responses 

appear to be species- and cultivar-specific. Additionally, the lack of intumescence development 
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on any of the cultivars throughout the experiment raises additional questions regarding causative 

factors for this disorder and whether lighting strategies may be useful in suppression. Therefore, 

future research should evaluate EOD and PD lighting strategies under active intumescence 

development to determine possible suppression mechanisms as well as increase the duration of 

lighting treatments to more fully evaluate possible impacts on pepper morphology and fruit 

quality.  
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Table 4. Mean  SD daily light integral (DLI), temperature, relative humidity, and CO2 

concentration across two experimental replications (benches) during the day (0700-1900 hr) and 
night (1900-0700 hr) from 22 Aug 2024 - 06 Sept 2024. 
 

DLI 

mol·m−2·d−1 

Temp. 

°C 

Humidity 

% 

CO2 

μmol·mol−1 

Day  18.9  4.7 24.5  0.5 45.1  4.6 471.5  7.8 

Night  − 21.4  1.1 48.4  7.6   500.8  11.6 
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Table 5. Mean  SD photon flux density (μmol·m−2·s−1) of blue (400-500 nm), red (600-700 nm), 

or far-red (700-800 nm) end-of-day (EOD) or pre-dawn (PD) lighting treatments provided by 
tunable LED fixtures (Elixia; Heliospectra, Gothenburg, Sweden). 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 65 

Table 6. Least square means for total leaf dry mass (TLDM), stem dry mass (SDM), total dry mass (TDM), height, compactness, 
imaged leaf mass area (ILMA), number of fruits, and number of flowers for pepper (Capsicum annuum) ‘California Wonder’, ‘Pot-a-
Peño’, and ‘Spicy Jane’ plants subjected to one of four 30-minute lighting treatments at an intensity of 25 μmol·m−2·s−1 for two weeks 

provided at either EOD (2030 HR) with blue (EODB), red (EODR), or far-red light (EODFR), or pre-dawn (PD; 0500 HR) with blue 
light (PDB).  
 

Cultivar Lighting 

Treatment  

TLDM 

(g) 

SDM 

(g) 

TDM 

(g) 

Height 

(cm) 

Compactness 

(g·cm
–1

) 

ILMA 

(mg·cm
–2

) 

Fruit Number Flower 

Number 

California 

Wonder 

EODB   5.3
z
 b

y
 2.4 b 7.7 b 45.9 0.051 b 2.88 0.1 b 3.2 

EODR   5.7 ab    3.1 ab  8.8 ab  51.0   0.061 ab  2.91    0 b 5.2 

EODFR 5.1 b 2.6 b  7.7 b  48.1 0.052 b  2.87    0 b 3.9 

PDB 6.5 a 3.7 a  10.2 a  50.9 0.072 a  2.89 0.8 a 5.1 

          

Pot-a-Peño 

EODB 6.2 3.9 10.1   50.6 ab 0.077 3.18 5.40 a 11.3 

EODR 5.5 3.7 9.3 52.4 a  0.072 2.92   4.70 ab 9.8 

EODFR 5.7 3.6 9.3   51.1 ab 0.070 3.13 2.70 b 10.8 

PDB 5.8 3.4 9.2 47.4 b 0.071 3.08 3.30 ab 9.7 

          

Spicy Jane 

EODB 5.9 4.1 10.0   52.1 ab 0.079 2.87 11.30 20.6 

EODR 5.6 4.3 9.9 54.2 a 0.079 2.64 8.30 23.5 

EODFR 5.7 4.0 9.6   52.2 ab 0.076 2.62 7.30 21.5 

PDB 5.8 3.8 9.6 49.9 b 0.076 2.82 10.30 19.1 
z
Mean values are based on ten plants across two experimental replications.   

yMeans sharing lettering are not statistically different using Tukey’s honestly significant difference at P ≤ 0.05.  
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Figure 7. Imaged leaf area expansion (ILAE; cm2) for pepper (Capsicum annuum) ‘California 
Wonder’ plants subjected to one of four 30-minute lighting treatments at an intensity of 25 
μmol·m−2·s−1 for two weeks provided at either EOD (2030 HR) with blue (EODB), red (EODR), 
or far-red light (EODFR), or pre-dawn (PD; 0500 HR) with blue light (PDB). Means with no 
lettering are not statistically different using Tukey’s honestly significant difference at P ≤ 0.05. 
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Figure 8. Imaged leaf area expansion (ILAE; cm2) for pepper (Capsicum annuum) ‘Pot-a-Peño’ 
plants subjected to one of four 30-minute lighting treatments at an intensity of 25 μmol·m−2·s−1 

for two weeks provided at either EOD (2030 HR) with blue (EODB), red (EODR), or far-red light 
(EODFR), or pre-dawn (PD; 0500 HR) with blue light (PDB). Means with no lettering are not 
statistically different using Tukey’s honestly significant difference at P ≤ 0.05. 
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Figure 9. Imaged leaf area expansion (ILAE; cm2) for pepper (Capsicum annuum) ‘Spicy Jane’ 
plants subjected to one of four 30-minute lighting treatments at an intensity of 25 μmol·m−2·s−1 

for two weeks provided at either EOD (2030 HR) with blue (EODB), red (EODR), or far-red light 
(EODFR), or pre-dawn (PD; 0500 HR) with blue light (PDB). Means with no lettering are not 
statistically different using Tukey’s honestly significant difference at P ≤ 0.05. 

 

 

 

  



 

 69 

3.7 Literature Cited 

Both AJ, Faust J. 2017. Light transmission: The impact of glazing material and greenhouse 

design, p 59-66. In: Lopez and Runkle (eds.) Light management in controlled 

environments. Meister Media Worldwide, Willoughby, OH, USA.  

Casal JJ. 2013. Photoreceptor signaling networks in plant responses to shade. Annu Rev Plant 

Biol. 64:403–427. https://doi.org/10.1146/annurev-arplant-050312-120221 

Chia PL, Kubota C. 2010. End-of-day far-red light quality and dose requirements for tomato 

rootstock hypocotyl elongation. HortScience. 45(10):1501–1506. 

https://doi.org/10.21273/HORTSCI.45.10.1501 

Claypool NB, Lieth JH. 2021. Modeling morphological adaptations of bell pepper (Capsicum 

annuum) to light spectra. Sci Hortic. 285:110135. 

https://doi.org/10.1016/j.scienta.2021.110135 

Cope KR, Snowden MC, Bugbee B. 2014. Photobiological interactions of blue light and 

photosynthetic photon flux: Effects of monochromatic and broad‐spectrum light 

sources. Photochem and Photobiol. 90(3): 574–584. https://doi.org/10.1111/php.12233  

Craver JK, Miller CT, Williams KA, Boyle DL. 2014. Characterization and comparison of 

lesions on ornamental sweetpotato ‘Blackie’, tomato ‘Maxifort’, interspecific geranium 

‘Caliente Coral’, and bat-faced cuphea ‘Tiny Mice.’ J Amer Soc Hort Sci. 139(5): 603–

615. https://doi.org/10.21273/JASHS.139.5.603 

Dou H, Niu G. 2020. Plant responses to light, p 153–166. In: Plant factory. Elsevier, Amsterdam, 

Netherlands. https://doi.org/10.1016/B978-0-12-816691-8.00009-1 

https://doi.org/10.1146/annurev-arplant-050312-120221
https://doi.org/10.21273/HORTSCI.45.10.1501
https://doi.org/10.1016/j.scienta.2021.110135
https://doi.org/10.21273/JASHS.139.5.603
https://doi.org/10.1016/B978-0-12-816691-8.00009-1


 

 70 

Eguchi T, Hernández R, Kubota C. 2016b. Far-red and blue light synergistically mitigate 

intumescence injury of tomato plants grown under ultraviolet-deficit light environment. 

HortScience. 51(6):712–719. https://doi.org/10.21273/HORTSCI.51.6.712  

Fan X, Zang J, Xu Z, Guo S, Jiao X, Liu X, Gao Y. 2013. Effects of different light quality on 

growth, chlorophyll concentration and chlorophyll biosynthesis precursors of non-

heading Chinese cabbage (Brassica campestris L.). Acta Physiol Plant. 35(9):2721–2726. 

https://doi.org/10.1007/s11738-013-1304-z.  

Gómez C, Currey C, Dickson R, Kim H, Hernandez R, Sabeh N, Raudales R, Brumfiled R, 

Laury-Shaw A, Wilke A, Lopez R, Burnett S. 2019. Controlled environment food 

production for urban agriculture. HortScience. 54(9):1448–1458. 

https://doi.org/10.21273/HORTSCI14073-19 

Hernández R, Kubota C. 2016. Physiological responses of cucumber seedlings under different 

blue and red photon flux ratios using LEDs. Environ Exp Bot. 121:66–74. 

https://doi.org/10.1016/j.envexpbot.2015.04.001 

Hernandez R, Kubota C. 2017. Light quality and photomorphogenesis, (p 29–37).. In: R Lopez, 

E Runkle (eds.). Light management in controlled environments. Meister Media 

Worldwide, Willoughby, OH, USA.  

Kubota C, Eguchi T, Kroggel M. 2017. UV-B radiation dose requirement for suppressing 

intumescence injury on tomato plants. Sci Hortic. 226:366–371. 

https://doi.org/10.1016/j.scienta.2017.09.006 

Lang SP, Tibbitts TW. 1983. Factors controlling intumescence development on tomato plants1. J 

Amer Soc Hort Sci. 108(1):93–98. https://doi.org/10.21273/JASHS.108.1.93 

https://doi.org/10.21273/HORTSCI.51.6.712
https://doi.org/10.1007/s11738-013-1304-z
https://doi.org/10.21273/HORTSCI14073-19
https://doi.org/10.1016/j.envexpbot.2015.04.001
https://doi.org/10.1016/j.scienta.2017.09.006
https://doi.org/10.21273/JASHS.108.1.93


 

 71 

Lopez R, Fisher P, Runkle E. 2017. Introduction to specialty crop lighting, p 12-18. In: Lopez R, 

Runkle E (eds.). Light management in controlled environments. Meister Media 

Worldwide, Willoughby, OH, USA.  

Massa GD, Kim H-H, Wheeler RM, Mitchell CA. 2008. Plant productivity in response to LED 

lighting. Horts. 43(7):1951–1956. https://doi.org/10.21273/HORTSCI.43.7.1951 

Percival AC, Craver JK. 2023. End-of-day far-red lighting with a low daily light integral 

increases stem length but does not promote early leaf expansion for petunia ×hybrida 

seedlings. horts. 58(9):1010–1017. https://doi.org/10.21273/HORTSCI17132-23 

Runkle E, Lopez R, Fisher P. 2017. Photoperiodic control of flowering, p 38-47. In: Lopez R, 

Runkle E (eds.). Light management in controlled environments (1st ed). Meister Media 

Worldwide, Willoughby, OH, USA.  

Sita NC, Iriawati, Kiriiwa Y, Suzuki K. 2024. Intumescence: A serious physiological disorder in 

plants. RAS. 12(0):182–212. https://doi.org/10.7831/ras.12.0_182 

Sorauer P. 1922. Excessive humidity, p 435-457. In: Sorauer, Lindau G, Reh L (eds), Dorrance 

(transl.) Manual of plant diseases (3rd ed.). Record Press, Wilkes-Barré, PA, USA. 

Suzuki K, Ozawa C, Kiriiwa Y. 2020. Morphological study on the incidence of intumescence 

injury in tomato plant leaves. Hort J. 89(5):567–574. https://doi.org/10.2503/hortj.UTD-

187 

  

https://doi.org/10.21273/HORTSCI.43.7.1951
https://doi.org/10.21273/HORTSCI17132-23
https://doi.org/10.7831/ras.12.0_182
https://doi.org/10.2503/hortj.UTD-187
https://doi.org/10.2503/hortj.UTD-187


 

 72 

APPENDIX A – IMAGEJ ANALYSIS FOR LEAF EXPANSION 
 
 

 
Details of ImageJ Image Analysis for Leaf Expansion 

Steps of image capture and processing are as follows:  

1. Open ImageJ and import the file/image 

a. Using the “File” tab go to “Open” an image and select the desired photo to be 

used to set the scale, a secondary window will appear with the selected image 

2. Use the “Straight line” tool to draw a line on an object of a known size (e.g., a ruler) 

3. Go to “Analyze” then scroll to “Set Scale” 

a. Enter in the distance measured with the “Straight Line” tool  

b. Enter the desired measurement units 

c. Check the box “Global” (this will apply the same scale to all the images until the 

program is closed), then hit “OK” 

4. Isolating the tagged leaf 

a.  Choose “File” > “Open” and choose the photo for analysis  

b. Use the “Rectangle” tab to capture the leaf to be analyzed. Select the smallest 

rectangle around the leaf 

c. Choose “Image” > “Crop”, this will isolate the leaf to be analyzed  

5. Change the image to a binary image (black and white)  

a.  Choose “Process” > “Binary” > “Make Binary”  

b. Use the “Paintbrush Tool” to remove large clusters of pixels that are not part of 

the leaves. 
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c. Go to “Process” > “Noise” > “Remove Outliers” or Despeckle” to remove small 

specks that are not part of the leaves. This step can be skipped when the image 

has a clean background. 

6. Using the “Wand (tracing) Tool” select the area of the leaf to be measured. The selected 

area will be outlined with a yellow line and ensure only the leaf is captured.  

a. Go to “Analyze” > “Measure” and another window labeled “Results” will open 

with the area and perimeter measurements present in the units previously set when 

setting the scale 

7. Next choose the “Straight Line” tool and select two points, one at the end of the petiole 

and one at the tip of the leaf, to capture the length of the leaf 

a. The tool will draw a straight line between the two points (the petiole and the tip of 

the leaf) 

b. Choose “Analyze” > “Measure”, the measurement will populate in the “Results” 

window 

8. Next choose the “Straight Line” tool and measure the width of the leaf by choosing the 

widest points of the leaf margins 

a. The tool will draw a straight line between the two points (the widest point of the 

leaf margin) 

b. Choose “Analyze” > “Measure”, the measurement will populate in the “Results” 

window 

9. Once the desired measurements are captured for that photo, document the results for leaf 

and save the image as a .TIFF file  
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APPENDIX B – DROUGHT STRESS INITIATES INTUMESCENCE DEVELOPMENT FOR 

THREE CULTIVARS OF CAPSICUM ANNUUM 

 
 
 

B.1 Introduction 

Pepper (Capsicum annuum) production has recently expanded to controlled environments 

as a means of producing high quality edible and ornamental peppers year-round. However, 

balancing of production inputs, such as water and fertilizer, is critical to ensure quality and 

maximize yield. For many cultivars, production guidelines can be sourced directly from the 

breeding company and are typically published annually alongside new cultivar introductions 

[e.g., PanAmerican 2023 Seed Product Information Guide (PanAmerican 2023)]. These 

guidelines detail the pertinent information needed to successfully produce a crop from 

propagation to finishing. For example, detailed watering guidelines outline stage-specific 

recommendations for pepper, assigning a level and a visual/tactile matrix to describe the desired 

moisture content (PanAmerican 2023). Using this guide, substrate moisture content ranges from 

Level 1: Dry (substrate color – very light brown or gray; substrate feel when squeezed – no 

moisture is detected in substrate; substrate structure – dusty and freely scatters when blown) to 

Level 5: Saturated (substrate color – brown-black, glistening with water; substrate feel when 

squeezed – water runs freely out of substrate; substrate structure – substrate has a semi-liquid 

consistency) (PanAmerican 2023). For peppers, this production guide recommends maintaining 

moisture content between Levels 4 and 2 during the root establishment phase, reducing to 

between Levels 3 and 1 up to flowering, and finally maintaining between Levels 4 and 2 

throughout flowering (PanAmerican 2022). Thus, it is common for pepper production to 

incorporate periods of limited water availability, often imposing drought stress.   
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Previous research has found water status to play a critical role in photosynthetic rates, 

flower and fruit development, as well as physiological disorders such as intumescence (Lang and 

Tibbits 1983; Mahmood et al. 2021; Miyama and Yasui 2021). Pepper can be susceptible both to 

water deficit and excess, primarily during flowering, with impacts to yield being of greatest 

concern for producers. In a study conducted by Ou et al. (2011), six pepper species (Capsicum 

annuum L., Capsicum baccatum L., Capsicum chinese, Capsicum frutescens L., Capsicum 

pubescens, and wild type Capsicum baccatum) were subjected to waterlogging events lasting 

between one to three days which resulted in decreased photosynthetic rate and reduced recovery 

time of photosynthetic rate and stomatal conductance to normal levels once drainage of 

excessive water occurred and regular irrigation resumed for all six species. In terms of water 

limitations, pepper cultivars ‘Pusajuala’, ‘Ghotki’, ‘Green Wonder’, and ‘PPE-311’ exposed to 

drought stress (35% field capacity) during flowering decreased reproductive growth and overall 

pungency compared to a control (65% field capacity), facilitating the development of appropriate 

irrigation thresholds for pepper (Mahmood et al. 2021). 

Previous research has identified a probable link between intumescence development and 

water status (Lang and Tibbits 1983; Miyama and Yasui 2021). Intumescence is a physiological 

disorder characterized by hypertrophy and hyperplasia of epidermal and palisade parenchyma 

cells on leaves, petioles, and stems of multiple plant species when produced in a controlled 

environment (Morrow and Tibbitts, 1988; Wetzstein and Frett, 1984). Excess water has been 

observed to cause intumescence development on tomato (Solanum lycopersicum) (Atkinson, 

1893) and potato (Solanum tuberosum) (Douglas, 1907) as well as other specialty crops. Rapid 

changes in water status have also been linked to this disorder; for example, Miyama and Yasui 

(2021) reported tomato ‘Momotaro Peace’, a cultivar shown to be susceptible to drought, 
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experienced the highest severity of intumescence injury when subjected to a reduced soil 

moisture content (~64%) followed by irrigation to field capacity compared to other cultivars in 

the study. These authors proposed that sudden increases in soil moisture content during periods 

when xylem pressure potential is low (indicative of drought) may result in water absorption 

temporarily exceeding transpiration rate, likely leading to cellular rupture and the characteristic 

injuries associated with intumescence (Miyama and Yasui 2021).  

For crops that are susceptible to intumescence injury, effective watering is a potentially 

cost-effective means to control intumescence, which may otherwise limit adaptability for 

controlled-environment production systems. However, current guidelines for production which 

impose drought stress may facilitate the development of this disorder. We hypothesize that the 

combination of drought stress followed by a thorough irrigation event will result in intumescence 

development for susceptible pepper cultivars, thus providing insight on managing a potential 

environment stimulus for the development of this physiological disorder. Results may lead to a 

cost-effective strategy for alleviating intumescence injury on susceptible pepper cultivars 

produced in a controlled environment via appropriate irrigation strategies as well as further the 

scientific understanding of causative factors and mechanisms pertaining to this disorder.  

B.2 Materials and Methods  

B.2.1 Plant Materials and Greenhouse Environment 

Pepper cultivars ‘California Wonder’, ‘Pot-a-Peño’, and ‘Spicy Jane’, were evaluated 

during the winter of 2025. On 16 Jan. 2025, seeds of each cultivar were single sown into 128-cell 

trays using commercial soilless germination media (Berger BM2 Seed Germination; Berger, 

Saint-Modeste, Quebec City, CA) then covered lightly with vermiculite (Sun Gro® Horticultural 

Vermiculite Premium Grade Medium A-2 Coarse, Sun Gro®, Agawam, MA, USA). Trays were 
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irrigated as needed using Jack’s water-soluble fertilizer (Jack’s 13N–0.9P–10.8K Plug LX; J.R. 

Peters, Inc., Allentown, PA, USA) providing 75 mg·L–1 nitrogen. Nutrient solution pH and 

electrical conductivity (EC) were monitored using a handheld meter (Bluelab Combo Meter; 

Bluelab, Tauranga, New Zealand). Seedling trays were germinated under fitted plastic domes for 

three weeks. Upon germination humidity domes were removed. Seedlings were transplanted into 

15-cm standard plastic pots on 6 Feb 2025. Transplants were irrigated every other day using a 

water-soluble fertilizer (Jack’s 21N–2.2P–16.7K; J.R. Peters, Inc., Allentown, PA, USA) 

providing 150 mg·L–1 nitrogen. Seedling trays and transplants were grown and maintained in a 

greenhouse located at the Colorado State University Horticulture Center in Fort Collins, CO, 

USA. Greenhouse environmental conditions were controlled using a VeriStep dynamic control 

system (Wadsworth Control System, Arvada, CO, USA) with an air temperature set point of 

22/20 °C (day/night) (Table 1). Air temperature (°C), relative humidity (RH), photosynthetic 

photon flux density (PPFD), and carbon dioxide (CO2) concentration were monitored and logged 

every 10 min using an aspirated datalogger (Guardian SM-600; Apogee® Instruments, Logan, 

UT, USA), with data compiled in Table 7.   

B.2.2 Irrigation Treatments and Data Collection 

On 24 Feb 2025, all plants, regardless of treatment, were watered and allowed to drain to 

container capacity for experiment initiation. Three plants per cultivar were designated to a “well-

watered” treatment serving as the control and three plants per cultivar were designated to a 

“water stress” treatment. Plants in the control were watered as needed to maintain 70% of 

container capacity, while plants in the water stress treatment were allowed to reach 40% of 

container capacity prior to an irrigation event. Percentages of container capacity were calculated 

using a saturation value of 800g measuring the whole plant. Guidance as to appropriate irrigation 



 

 78 

regimes for pepper were sourced from Pan American Seed (PanAmerican 2022) for the 

development of treatment thresholds. Plants were weighed daily at 0900 and 1700 HR using a 

digital balance (Ohaus Adventurer™ Pro Precision AV4101C, Parsippany, NJ, USA) to 

determine the timing of irrigation events. Once the water stress treatment reached the pre-

determined threshold all plants were watered to field capacity signaling the watering event. 

All plants were evaluated twice daily (0900 and 1700 HR) for intumescence development 

over the course of the 12-d experiment. Special attention was given 2-d prior, and 5-d post the 

irrigation event for the water stress treatment to capture the timing of intumescence development. 

Leaves showing signs of intumescence were tagged, indicating the time and date of the 

observation. Additionally, node number from the apical meristem for tagged leaves was recorded 

and leaf images collected. Leaf imaging was conducted using a digital camera (Hero12 Black, 

GoPro, San Mateo, California, USA), affixed with a 15X lens (15X Macro Lens, QKOO, China) 

connected to a 15 cm  23 cm white clipboard via a gooseneck clamp (Suptig Jaws Flex Clamp 

Gooseneck Mount, Suptig, Shenzhen, China) to maintain a fixed static position. 

 Destructive data was collected on 8 March 2025 and included plant height (measured in 

cm from the base of the stem to the apical meristem), and number of leaves with/without 

intumescence injury. The stem of each plant was cut at soil level, and leaves were removed at the 

node to be counted. All vegetative plant material (tagged leaves, stems, and non-tagged leaves) 

of each plant were separated and dried at 70 °C for 3 d to determine the dry mass using an 

analytical microbalance (Analytical Balance ME54E; Mettler-Toledo, LLC, Columbus, OH, 

USA).  
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B.2.3 Statistical Analysis 

Two replicates of three plants per cultivar per treatment were conducted simultaneously, 

blocked by bench. Within each bench, plant positions were rotated daily to ensure uniformity. 

The experiment was a randomized complete block design with irrigation treatment as a factor 

and bench as a blocking variable. Data analysis for each replication was combined and 

represented in the data reported. The effects of irrigation treatment were compared by analysis of 

variance (ANOVA) using jamovi [jamovi version 2.6 (The jamovi project, 2025)] with Tukey’s 

honestly significant difference (HSD) test at P ≤ 0.05.  

B.3 Results and Discussion 

All plants in the water stress treatment were allowed to dry down to between 320 – 350g 

followed by a one-time watering event. The water stress treatment reached the pre-determined 

threshold on 02 Mar 2025 at the 0900 HR interval, and all plants were watered to container 

capacity on 02 Mar 2025 at the 1700 HR interval signaling the watering event. The following 

morning at the 0900 HR observation, intumescence development was observed on 75% of ‘Pot-

a-Peño’ and ‘Spicy Jane’ plants in the water stress treatment and 100% of ‘Pot-a-Peño’ and 

‘Spicy Jane’ plants the following day (Fig. 11 and 12), there was no intumescence development 

observed before the watering event on any plants. Intumescence development was observed on 

16% and 43% of the total leaves for ‘Spicy Jane’ and ‘Pot-a-Peño’, respectively, over the course 

of the 12 d experiment (data not shown). For ‘California Wonder’, intumescence development 

occurred 3 d post the watering event for the water stress treatment and only impacted 10% of the 

plants (Fig. 10). For ‘California Wonder’ plants affected, intumescence development was 

observed on 25% of the total leaves present over the course of the 12 d experiment (data not 

shown). Intumescence development occurred between the 4th and 9th node from the apical 
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meristem for ‘Pot-a-Peño’ and ‘Spicy Jane’ and on the 4th and 5th node for ‘California Wonder’ 

(data not shown). For all cultivars, plants in the control treatment exhibited no signs of 

intumescence injury over the course of the 12 d experiment. Based on the data from the present 

experiment, it is likely that intumescence development for pepper is dependent on cultivar-

specific drought tolerance. For example, Miyama and Yasui (2021) reported that tomato 

‘Momotaro Peace’ exhibited a significant decrease in xylem pressure potential (i.e., lower 

drought tolerance) under dry soil moisture conditions and, as a result, developed severe 

intumescence injury following sudden increases in soil moisture when compared to the more 

drought-tolerant cultivars ‘Reiyo’ and ‘CF House Momotaro’. While the exact mechanism for 

intumescence development is still unclear, water stress has been shown to induce hormonal 

responses regulating stomatal closure to prevent water loss which can lead to the buildup of 

reactive oxygen species (ROS) damaging plant tissues (Mahmood et al. 2021). This additional 

oxidative stress may contribute to intumescence injury as characterized by abnormal cellular 

proliferation and cell wall changes (Mahmood et al. 2021). The presence of intumescence injury 

can also affect leaf water content. Suzuki et al. (2020) investigated intumescence development 

on tomato ‘Rinka 409’ under normal [natural ultraviolet (UV) in a glass greenhouse] or low 

(supplied via fluorescent lamp) UV radiation conditions and reported that plants grown under 

low UV radiation developed intumescence and reduced water content (86.2%), while those under 

normal UV radiation showed no signs of the disorder and higher water content (90.88%). 

Importantly, tomato plants with intumescence injury exhibited a significant reduction in leaf 

water content compared to plants without injury. Their results suggest leaf water status can be 

greatly impacted by intumescence development and, as a result, affect the plants’ ability to fully 

recover from water stress (Suzuki et al. 2020). 
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While results from the present study show that drought stress may be a causative factor in 

the development of intumescence for susceptible pepper cultivars, further research is needed to 

clarify the timing (temporal and developmental) in which intumescence development occurs as 

well as determining water stress thresholds. These finding could further support pepper 

production in controlled environments by providing cost-effective irrigation recommendations 

that promote yield and quality while also preventing intumescence development. 
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Table 7. Mean  SD daily light integral (DLI), temperature, relative humidity, and CO2 

concentration across two experimental replications (benches) during the day (0700-1900 HR) and 
night (1900-0700 HR) from 06 Feb 2025 - 07 Mar 2025. 

 
DLI 

mol·m−2·d−1 

Temperature 

°C 

Humidity 

% 

CO2 

μmol·mol−1 

Day  13.5 ± 3.5 21.8 ± 1.4 19.1 ± 5.3 596.6 ± 42.9 

Night  − 20.9 ± 0.8 22.7 ± 4.3 647.8 ± 51.9 
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Figure 10. Left axis: Plant weight (g) showing the average of six plants per day for pepper 
(Capsicum annuum) ‘California Wonder’ after either being watered as needed to maintain 70% 
of container capacity (Control; dashed dark gray line) or allowed to reach 40% of container 

capacity (Water stress; solid light gray line) prior to an irrigation event (green line). Right axis: 
Percentage of plants showing symptoms of intumescence development for the Control (blue line) 
or Water stress treatment (red line). All plants were evaluated twice daily (0900 and 1700 HR) 
for intumescence development over the course of the 12 d experiment. 
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Figure 11. Left axis: Plant weight (g) showing the average of six plants per day for pepper 
(Capsicum annuum) ‘Pot-a-Peño’ after either being watered as needed to maintain 70% of 
container capacity (Control; dashed dark gray line) or allowed to reach 40% of container 

capacity (Water stress; solid light gray line) prior to an irrigation event (green line). Right axis: 
Percentage of plants showing symptoms of intumescence development for the Control (blue line) 
or Water stress treatment (red line). All plants were evaluated twice daily (0900 and 1700 HR) 
for intumescence development over the course of the 12 d experiment. 
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Figure 12. Left axis: Plant weight (g) showing the average of six plants per day for pepper 
(Capsicum annuum) ‘Spicy Jane’ after either being watered as needed to maintain 70% of 
container capacity (Control; dashed dark gray line) or allowed to reach 40% of container 

capacity (Water stress; solid light gray line) prior to an irrigation event (green line). Right axis: 
Percentage of plants showing symptoms of intumescence development for the Control (blue line) 
or Water stress treatment (red line). All plants were evaluated twice daily (0900 and 1700 HR) 
for intumescence development over the course of the 12 d experiment. 
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